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Chapter 1 Introduction

1.1  About Atlas
Atlas provides tools for you to load, view, manipulate, locate, and save digital seismo-
graph data from Earthworm databases, SEED files, and Nanometrics data servers.

Generate trace data packages—events—using data from Nanometrics data servers, 
picks, and analysis results
• Access data from Earthworm V6.0 and 6.1 databases and Nanometrics data 

servers over any network or Internet connection
• Save events from one database to another
• Import/export SEED version 2.3 files
View and pick events using the intuitive interface
• Sort traces by first phase time or by channel name
• View multiple events simultaneously from several data sources
• Edit event and solution names
Edit existing events—create phase, duration, and amplitude picks, create multiple 
solutions, and manipulate trace data
• Correct for instrument response
• Do magnitude estimations:

based on corrected signal amplitude
based on duration
calculated using Hypoinverse

• Calculate event location solutions, using Hypoinverse
• Edit the Hypoinverse phase input file
• Add comments to solutions and events
Use simple and robust methods to create digital filters and apply them individually 
or as a group to trace data
• Instrument deconvolution
• Instrument simulation
• Trend removal
• Ground motion conversion
• S-plane and Z-plane filters, using either poles and zeroes or coefficients for the 

transfer function
Atlas Version 1.2
User Guide

14389R5
2005-01-20 1



Chapter 1: Introduction
• Butterworth filters
Work with fully interactive maps that combine a geographical display of stations 
and epicentres with various attributes of the event—see which stations contributed 
to the solution, make adjustments, calculate a new solution, and compare with 
another solution
• Load and display maps that use any of several file formats:

ArcInfo
ESRI shape files
DTED
Raster files – JPEG and GIF

• Apply various projections:
Mercator
Lambert Conformal Conic
Stereographic
Identity projection (no projection)

• Customise map data settings—almost any aspect of an event can be shown, be 
it a P-pick residual or a magnitude, using a variety of widgets

• Refine solutions with the interactive station and solution options
Do a spectral analysis of any trace or trace segment
Easily create HTML bulletins to view and distribute summaries of events

1.2  About this User Guide
This guide provides overview information, detailed procedures, and reference informa-
tion. Information about system requirements, software versions, installation instruc-
tions, and database maintenance instructions are included in the separate “Atlas 
Installation and Maintenance Guide”.

Part 1, “Getting Started”, provides basic procedures for setting up a new installation, 
and an introductory tour of the main features:

Chapter 1, “Introduction” – an overview of Atlas and this user guide.
Chapter 2, “Setting Up A New Installation” – an overview of the steps required to 
do a basic setup of a new installation of Atlas.
Chapter 3, “A Quick Tour of Atlas” – an introductory tour of the main features of 
Atlas.

Part 2, “Working with Atlas”, includes an overview of data storage and access, and pro-
cedures for using Atlas to store, access, and examine data:

Chapter 4, “Data Sources and Catalogs” – procedures for working with Earthworm 
compatible databases, Nanometrics data servers, and SEED files: to create and 
remove connections to data sources as needed, view data source connection prop-
erties, and create catalogs for working with various types of trace data.
Chapter 5, “Event Data” – procedures for working with event data: to load, save, 
and copy events, locate and edit solutions, and annotate events.
Chapter 6, “Filters” – procedures for creating digital filters and applying them to 
trace data, and saving single filters and groups of filters for future use. This chap-
ter includes a section on instrument response utilities for instrument deconvolu-
Atlas Version 1.2
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tion, instrument simulation, and for determining the ground motion measured 
when converting between motion types.
Chapter 7, “Power Spectra” – an overview of how power spectra are calculated, 
and procedures for calculating and plotting spectra for any trace or trace segment.
Chapter 8, “Maps” – procedures for loading maps, and using map utilities to refine 
solutions.

Part 3, “Appendices”, provides reference information:
Appendix A, “Hypoinverse” – information on how to install Hypoinverse, and an 
overview of how Atlas uses that application. Additional information is provided in 
the separate Atlas Installation and Maintenance Guide.
Appendix B, “Earthworm” – an overview of the relationship between Atlas and 
Earthworm.
Appendix C, “Response File Format” – an overview of Nanometrics response file 
format, and an example of a response file.
Appendix D, “Troubleshooting” – answers to some questions that may arise as you 
use Atlas.
Atlas Version 1.2
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Chapter 2 Setting Up A New 
Installation

This chapter contains basic interface navigation information, an overview of Atlas data 
storage, and initial setup instructions for a new installation of Atlas. For information on 
installing Atlas and setting up Hypoinverse, and for information about version compat-
ibility for Atlas and related software, see the separate “Atlas Installation and Mainte-
nance Guide”.

2.1  Navigating in Atlas
This section provides a summary of conventions for navigating within Atlas, a brief 
overview of the main menu options, and an overview of the Atlas option settings.

2.1.1   User interface conventions

Table 2-1  Conventions for keyboard and mouse actions

Action Description

Click Tap the left mouse button while the mouse pointer is on the selected item.

Double click Tap the left mouse button twice while the mouse pointer is on the selected 
item.

Right click Tap the right mouse button while the mouse pointer is on the selected item.

Key1-Key2 Hold down Key1 while pressing Key2 (for example, Shift-Tab to move back 
through options in a window; Shift-click to add a pick to a trace).

Table 2-2  General navigation mouse actions 

Option Mouse action

Select an item Click

Open an item Double click

Open a menu related to an item Right click
Atlas Version 1.2
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Chapter 2: Setting Up A New Installation
Data sources, catalogs, and files are organised in a file tree (for example, Figure 2-1). 
The key looks like  when it is open and  when it is closed.

To open or close a tree node, either double click on the node title or click on the 
key.

Trace images will open in the Event window (Figure 2-2) on the Atlas event desktop. 
Event maps will open in a new window (click the Show map button  in the main 
toolbar).

Table 2-3  General navigation keyboard commands 

Option Keyboard command

Move the cursor to the next button or option. Tab

Move the cursor to the previous button or option. Shift-Tab

Select the button or option. Space

Activate all selected options. Enter

Figure 2-1  Tree structure for event data

Figure 2-2  Traces in the Event window

Table 2-4  Trace and map image mouse actions

Option Mouse action

Move the image left, right, up, or down. Click and drag left, right, up, or down.
Atlas Version 1.2
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2.1.2   Main menus

Atlas has four main menus that are always available—File, View, Tools, and Help—
and the Event menu that is available when an event is open and selected.

Zoom the image at the mouse pointer location. Right click and drag up or down, or use the 
mouse wheel to zoom amplitude.

Add a pick to a trace or move a pick. Select the type of pick 
to add—phase (P or S), duration, or amplitude—using the 
pick tool on the toolbar.

Shift-click on the trace.

Select the trace as the current trace in an active event. Click on the trace.

Open a pop-up menu for a pick or a map icon. Right click on the pick or icon.

Open a pop-up menu for a trace. Right click on the trace.

Table 2-4  Trace and map image mouse actions (Continued)

Option Mouse action

Table 2-5  File menu options

Option Function

Save Save the active event in the current location.

Save As Save the event to a different database.

Save All Save all of the open events in the current location.

Close Close the active event window.

[event name] Load the event (shown in the list of recently accessed events).

Exit Close Atlas, with the option to save events that were changed during the 
session.

Table 2-6  View menu options

Option Function

Toolbar Click the toolbar name in the list of options—Event, Solution, and Tool toolbars—
to toggle display of the toolbar on or off. Toolbars display along the top of the Atlas 
main window.

Table 2-7  Event menu options

Option Function

Create Bulletin Create an HTML page summarising the event that is currently selected 
on the event desktop.

Edit Comment For events in an Earthworm database with Atlas extensions, add new 
comments to events, and edit existing comments.

Export to Y Files Export trace data for the selected event to Y-files.

Sort Traces By Sort traces in the event window, either by station name or by phase time.
Atlas Version 1.2
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2.2  About Atlas data storage
This section gives an overview of Atlas data storage elements—data sources and cata-
logs. See Section 2.3, “Set up a new installation of Atlas,” on page 12 for basic proce-
dures, and Chapter 4, “Data Sources and Catalogs” for detailed procedures.

Atlas uses three types of data source to store event data: Earthworm compatible data-
bases, Nanometrics data servers, and SEED files. Atlas uses data groupings called cat-
alogs to organise events, channels, and triggers. You can create and remove data 
sources and catalogs as needed, and modify catalogs. (Creating and removing data 

Table 2-8  Tools menu options

Option Function

Customize Use the Atlas Options dialog box (Figure 2-3) to customise 
various aspects of Atlas:
• Display – Set the location of sub-panels in the main Atlas win-

dow, the amount of memory to use to cache trace drawings, 
and which trace data point information to display in the status 
bar.

• Events – Select the quantity of extra trace data to obtain when 
loading a trigger or an event.

• Filters – When generating FIR filters that simulate S-plane fil-
ters, select the maximum number of coefficients to use, FIRcut-
off (% of peak), and the padding algorithm.

• Location – Show Hypoinverse results, allow Hypoinverse edits, 
and access the Hypoinverse Settings Editor window.

• Directories – set the default directories to save event bulletins 
and Y Files.

Unlock Events Unlock an event for editing (an event may be locked if a session 
is shut down abnormally or if the database is shut down while 
Atlas is running).

Table 2-9  Help menu options

Option Function

Atlas Help Launch an electronic copy of this guide.

About Atlas View the version information about the copy of Atlas that is installed.

Figure 2-3  Atlas Options dialog box
Atlas Version 1.2
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Chapter 2: Setting Up A New Installation
sources and catalogs, and modifying catalogs, essentially means modifying the connec-
tion definitions through which Atlas accesses the stored data.)

The initial Atlas setup includes an empty Data Sources folder. To use a new installation 
of Atlas, you need to do three things:

1. Set up a data source and catalog structure to load and store event data.

2. Define data sources.

3. Define catalogs within the data sources to list event data.

2.2.1   Data sources

Atlas can access three types of data source: Earthworm compatible databases, Nano-
metrics data servers, and SEED files.

Note For Atlas using Oracle connections: Before you can access a particular 
database, you need to use an Oracle assistant to list the database in your 
Oracle settings. See the sections in the “Atlas Installation and Mainte-
nance Guide” on adding a database to the client.

2.2.1.1    Earthworm compatible databases

Earthworm compatible databases provide the capacity to store and retrieve events over 
a local network or an Internet connection. You can create, modify, and remove connec-
tions to databases.

Earthworm compatible databases that do not have Atlas Extensions are read-only; 
Earthworm compatible databases with Atlas Extensions are writeable. 

2.2.1.2    Nanometrics data servers

Nanometrics data servers provide access to seismic sensor data and automatically-
detected events and triggers. You can create, modify, and remove connections to data 
servers.

A Nanometrics data server includes Nanometrics data files (Naqs ringbuffers and event 
list files) and the Nanometrics DataServer utility. The DataServer utility provides Atlas 
with access to the Nanometrics data via a TCP/IP connection. Seismic, state-of-health, 
and serial data are stored in ringbuffer files; triggers and events are stored in event files.

2.2.1.3    SEED files

SEED file data can be imported and exported over a local network connection. You can 
create, modify, and remove connections to SEED files. (The current version of Atlas 
supports SEED version 2.3 files.)
Atlas Version 1.2
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2.2.1.3.1    SEED data source constraints

SEED files can be used in the same way as an Earthworm database, except for these 
limitations:

Some of the information that can be stored in the database for an event cannot be 
saved to a SEED file, thus a SEED file event will contain less information than one 
saved to the database. Information that cannot be stored in a SEED file includes:
• Duration phases
• Amplitudes
• Event and solution names
• Event and solution comments
• Station magnitudes
• Some of the detail information in an origin
Only current instrument response information can be saved—historical response 
information is not maintained.
Only information used by Atlas is stored in a SEED file. This means saving to a 
SEED file that contains information Atlas does not use will cause that information 
to be lost from the SEED file.
Very large SEED files (files larger than 20 MB) can be quite memory intensive on 
the Atlas client and may be slow for various operations.
The catalog options are more limited than for other data source types.

2.2.1.4    Read/write features of data sources

The read/write characteristics for each type of data source, and which aspects of write-
able databases are editable (for example, event names), are listed in Table 2-10.

Table 2-10  Read/write features of data sources 

Earthworm 
database

Earthworm 
database with 

Atlas Extensions
SEED file Nanometrics 

data server

can load events from yes yes yes yes

can save to no yes yes no

can delete from no yes yes no

has editable event names no yes no no

has editable solution names no yes no no

has event catalogs yes yes yes yes

has trigger catalogs no no no yes

has channel catalogs no no no yes
Atlas Version 1.2
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2.2.2   Catalogs

Catalogs provide criteria on which events are sorted into categories, and are necessary 
for listing events in a data source. Each type of data source—Earthworm databases, 
Nanometrics data servers, and SEED files—uses catalogs to organise event informa-
tion. You can create catalogs to view events or event data meeting specific criteria, and 
modify and remove the catalogs as needed.

The types of catalogs that can be created depend on the data source type:
Earthworm database catalogs:
• Unlocated events
• Located events
Nanometrics data server catalogs:
• Trigger
• Channel
• Event
SEED file catalogs:
• Events

2.2.2.1    Earthworm database catalogs

Earthworm database catalogs can be defined to contain either unlocated events, or 
located events with a range of characteristics.

An Earthworm unlocated event catalog will contain all unlocated events for the 
source.
Earthworm located event catalogs can be defined on combinations of temporal, 
epicentre, depth, and magnitude criteria. These events are searched on the basis of 
their preferred solution.

You can create, modify, and remove Earthworm event catalogs. You can update the list 
of events, and delete events from a catalog.

2.2.2.2    Nanometrics data server catalogs

Nanometrics data servers provide access to trace data as received from seismic sensors. 
You can create three types of Nanometrics data server catalogs:

Channel catalogs
Nanometrics event catalogs
Trigger catalogs

A channel represents trace data for an individual sensor. In addition, Nanometrics data 
servers can provide automatic pick and event detection. A trigger is an automatically 
generated pick, which represents a time and a channel when a spike or anomaly 
occurred in the seismic trace.

2.2.2.2.1    Channel catalogs

Channel catalogs display a list of available channels of trace data. You can create, mod-
ify, and remove channel catalogs.
Atlas Version 1.2
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2.2.2.2.2    Nanometrics event catalogs

Nanometrics event catalogs list events that have been detected automatically by the 
Nanometrics data servers. You can create, modify, and remove Nanometrics event cat-
alogs. You can update the list of events, and clear the list.

Caution All trace data and triggers are reloaded from the ringbuffers when an 
event is opened. Therefore, once the trace data expires from the ring-
buffers, events will load blank traces. To preserve trace data for inter-
esting events, save the events to an Earthworm database.

2.2.2.2.3    Trigger catalogs

Trigger catalogs list picks that have been detected automatically by the Nanometrics 
data servers. Events are generated when enough channels trigger within a short enough 
time period (see also NaqsServer documentation). Individual channels may experience 
spikes and generate triggers.

You can create, modify, and remove trigger catalogs. You can update the list of triggers 
in a catalog, and clear the list.

2.2.2.3    SEED file catalogs

SEED file catalogs can be defined to contain events for a given time period, or to con-
tain all events if a time period is not specified. Events are exported from SEED files, or 
saved from Earthworm databases or Nanometrics data servers. (See Section 2.2.1.3.1 
on page 10 for information on SEED file limitations.)

2.3  Set up a new installation of Atlas
When you start Atlas for the first time, the Catalogs tabbed panel will contain an empty 
folder called Data Sources. Before data can be loaded in Atlas, you must create a struc-
ture of data source(s) and catalogs. Procedures for defining data source connections and 
catalogs are the same for both the initial setup, described below, and for subsequent 
additions to the data source and catalog structure, described in Chapter 4.

Setting up a new installation requires three general steps:

1. Connect to an Earthworm compatible database (Section 2.3.1 on page 13) or a 
SEED file (Section 2.3.2 on page 13).

2. Connect to a Nanometrics data server (Section 2.3.3 on page 14).

3. Create catalogs to organise and view data (Section 2.3.4 on page 14).

Note For Atlas using Oracle connections, before you can access a particular 
database you need to use an Oracle assistant to list the database in your 
Oracle settings. See the sections on adding databases to the client in the 
“Atlas Installation and Maintenance Guide”.
Atlas Version 1.2
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2.3.1   Connect to an Earthworm database
1. Right click on the Data Sources node in the Catalogs panel, and then click New 

Source in the pop-up menu (Figure 2-4).

2. In the Select Data Source dialog box, click the Earthworm tab, and then type the 
appropriate values for your system in the fields for Database name, User name, 
and user Password (Figure 2-5). (These values are defined during the Atlas instal-
lation.)

3. Click Ok to create the Earthworm data source connection.

Once the source has been added to the Catalogs panel, it will appear under the Data 
Sources node as an Earthworm data source , and a connection is made to the data-
base.

2.3.2   Connect to a SEED file
1. Right click on the Data Sources node in the Catalogs panel, and then click New 

Source in the pop-up menu (see Figure 2-4).

2. In the Select Data Source dialog box, click the SEED tab (Figure 2-6).

Figure 2-4  Create the first data source connection

Right click the Data Sources node, and click New 
Source to open the Select Data Source dialog box.

Figure 2-5  Create an Earthworm Data Source connection

Figure 2-6  Create a SEED file connection
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3. Type in the path and file name of the SEED file, or click the Browse button to 
search the file system.

4. Click Ok to add the SEED file data source to the Catalogs panel tree.
Atlas will open a connection with the data source and attempt to gather data that 
meet the criteria. If the data source is unavailable, or if some of the database con-
nect settings are incorrect, a warning will be displayed.

Once the source has been added to the Catalogs panel, it will appear under the Data 
Sources node as a SEED data source .

2.3.3   Connect to a Nanometrics data server
1. Right click on the Data Sources node in the Catalogs panel, and then click New 

Source in the pop-up menu (see Figure 2-4 on page 13).

2. In the Select Data Source dialog box (Figure 2-7), click the Nanometrics tab, and 
then type the appropriate values for your system in the fields for Host, Port, User 
name, and Password. 
• Host is the name or IP address of the computer running the Nanometrics 

DataServer.
• Port is defined in the DataServer configuration file; it is typically 28002.
• User name and Password are defined in the DataServer configuration file.

3. Click Ok to add the data source to the Catalogs panel tree.

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

Once the source has been added to the Catalogs panel, it will appear under the Data 
Sources node as a Nanometrics data source .

2.3.4   Create event catalogs

2.3.4.1    Create an Earthworm catalog

You can define Earthworm catalogs to contain either unlocated events, or located 
events with specified characteristics.

An Earthworm unlocated event catalog will contain all unlocated events for the 
source.

Figure 2-7  Create a Nanometrics data source connection
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Earthworm located event catalogs can be defined on combinations of temporal, 
epicentre, depth, and magnitude criteria; these events are searched on the basis of 
their preferred solution.

1. Right click the Earthworm data source node, and then click New Catalog in the 
pop-up menu (Figure 2-8).

2. In the Catalog dialog box, select whether the catalog will list all unlocated events, 
or located events that meet some criteria:

To list all unlocated events, select Unlocated events in the Type panel.

To list located events:
i. Select Located events in the Type panel.
ii. Set the criteria for events to be listed using the options in the Temporal, 

Epicenter, and Other panels (see Section 4.1.2.2 on page 35 for a descrip-
tion of the options).

3. In the Catalog Name text box, type in a name for the catalog (replace the Unnamed 
default). This is the name of the catalog as it appears on the Catalogs panel.

4. Click Ok to create the [name of catalog] events catalog. (To discard the changes, 
click Cancel.)

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

Figure 2-8  Create an Earthworm catalog
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2.3.4.2    Create a Nanometrics catalog

Use this procedure to create a Nanometrics event catalog. For information on creating 
channel and trigger catalogs, see Section 4.2.2, “Nanometrics data server catalog 
options,” on page 38.

Caution All trace data and triggers are reloaded from the ringbuffers when an 
event is opened. Therefore, once the trace data expires from the ring-
buffers, events will load blank traces. Save important events to a write-
able data source (an Earthworm database with Atlas Extensions, or a 
SEED file) before data are lost.

1. Right click on the Nanometrics data server node, and then click New Catalog in 
the pop-up menu (Figure 2-9).

2. In the Catalog dialog box, click the Event tab, and then set the criteria for events to 
be listed in the Nanometrics event catalog:

To list all events for any time period and all amplitudes, leave all options unse-
lected.

To list events for a time period, use either the Start Time and End Time fields, 
or the Most Recent time period field and drop-down list.

The Start Time (oldest event) and End Time (most recent event) options are 
in GMT time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list.

To list events of a minimum amplitude for a defined time period, type the limit 
value in the Minimum Amplitude field.

3. In the Catalog Name text box, type in a name for the catalog.

4. Click Ok to create the Nanometrics event catalog, or click Cancel to discard the 
changes.

Figure 2-9  Open the Nanometrics catalog dialog box
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Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

2.3.4.3    Create a SEED catalog
1. Right click on the SEED file node, and then click New Catalog in the pop-up menu 

(Figure 2-10).

2. In the SEED Catalog dialog box, set the criteria for events to be listed in the SEED 
event catalog:

To list all events, leave all options unselected.

To list events for a specific time period, use either the Start Time and End Time 
fields, or the Most Recent time period field and drop-down list:

The Start Time (oldest event) and End Time (most recent event) options are 
in GMT time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list.

3. In the Catalog Name text box, type in a name for the catalog. This is the name of 
the catalog as it appears on the Catalogs panel.

4. Click Ok to create the SEED event catalog. (To discard the changes, click Cancel.)

Figure 2-10  Create a SEED catalog
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Chapter 3 A Quick Tour of Atlas

This chapter provides a basic overview of how to use Atlas to load, locate, and save 
earthquake events using an Earthworm database and a Nanometrics data server, and to 
refine solutions using map utilities. See the chapters in Part 2, “Working with Atlas”, 
for detailed procedures.

3.1  Starting Atlas for the first time
Atlas can be used to load, view, locate, edit, annotate, and save packages of seismic 
data (events). Atlas uses catalogs to organise events stored in data sources. Before you 
can access and examine data, you must first set up a data source and a catalog structure 
to load and store event data (steps 1 and 2 below). You can use the map utilities to refine 
solutions.

1. Define data sources.

2. Define catalogs.

3. Edit solutions.

4. Locate solutions.

5. Save events and solutions.

6. Refine solutions with the map utilities.

3.2  Define data sources
When you start Atlas for the first time, the tabbed panel on the left will display the Cat-
alogs tab, containing an empty folder called Data Sources. To define a data source, 
right click the empty Data Sources folder in the Catalogs panel, and then choose New 
Source from the pop-up menu (Figure 3-1). This will open the Select Data Source dia-
log box, where you can define a data source.
Atlas Version 1.2
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To save events, you must have at least one Earthworm database or SEED file defined, 
so your first database should be defined as an Earthworm database or SEED file. Once 
you have defined the data source, click Ok to connect to the data source. (A connection 
check is performed. If the Earthworm data source is not found, a warning will be dis-
played. If the SEED data source is not found, a dialog box will open, providing the 
option to create a new SEED source.)

The Catalogs window will now show an Earthworm icon  that represents an Earth-
worm database you can connect to, or a drive icon representing the path to a SEED file 

.

To make a new connection to a Nanometrics data server, right click on the Data Sources 
folder and click New Source. In the Select Data Source dialog box, select the Nanomet-
rics tab, and fill out the Host, Port, User, and Password fields (Figure 3-2). You will 
need the name or IP address of the machine that runs the Nanometrics data server. The 
port is defined in the DataServer configuration; it is usually 28002. The user name and 
password are determined during DataServer configuration.

Once you have defined the data source, click Ok to connect to the data source. (A con-
nection check is performed, and if the data source is not found, a warning will be dis-
played.)

You should now have at least two data sources listed on the Catalogs panel, one of 
which is either an Earthworm database or a SEED file, and the other a Nanometrics data 
server.

Figure 3-1  Create a new Earthworm data source

Figure 3-2  Create a new connection to a Nanometrics data source
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3.3  Define catalogs
The process of defining catalogs is different depending on the type of data source. For 
an Earthworm database, you can define catalogs to contain a subset of events sorted by 
time, location, depth, or magnitude (or by various combinations of these attributes).

To define an Earthworm catalog, right click on the Earthworm data source icon  and 
choose New Catalog (Figure 3-3). 

Set the Temporal – Most Recent field to load events for the previous 2 days, type in 
EW2days in the Catalog Name field, and then click Ok. You may not have any events 
in this catalog, but as you save events that fit these criteria, the catalog will fill up.

To create a Nanometrics data server catalog, right click on the Nanometrics icon , 
and then select New Catalog to open the Catalog dialog box (Figure 3-4). The Catalog 
dialog box has three tabs: Channel, Event, and Trigger.

For now, just create an Event catalog: Click the Event tab, then choose the most recent 
events for the previous 2 days. Type in a Catalog Name NMX2days and then click Ok. 
If you double click on the new catalog, you will see all events for the last two days. (If 
there were no events in the previous two days, the catalog will contain only the entry 
“No events”. In this case, try other time period settings to load events.) 

Figure 3-3  Create an Earthworm catalog
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3.4  Edit solutions
You will need to open an event before you can locate or edit solutions. To open an 
event, double click on an event from the NMX2days catalog. An Event window will 
open on the Event desktop, displaying trace information for each channel. The Event 
Window provides various widgets for manipulating the view of the trace (Figure 3-5).

Traces can be displayed in the Zoom trace panel, which displays the currently active 
trace, the Pick trace panel, which displays the trace centred around the pick if there is 
one, and the Main trace panel. You can zoom in and out on these trace views by using 
the zoom toolbar buttons, or using the mouse wheel to zoom amplitudes. In addition, 
you can view individual samples by clicking the data point button  on the Atlas win-
dow toolbar, then zooming in to the point where you can see the data points (shown as 
Xs).

You can now review the trace data and add new picks to the trace, and adjust existing 
picks. To add a P-pick or an S-pick to a trace, select the appropriate button on the Atlas 

Figure 3-4  Create a new Nanometrics catalog

Figure 3-5  Event window trace panels and toolbars
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Chapter 3: A Quick Tour of Atlas
window toolbar (for example, use the  button for P-picks and the  button for S-
picks), and then click on the trace. Use the pick trace view of the data to refine the pick 
time by clicking and dragging the pick. (See also Section 5.4.1, “Changing the view of 
a trace,” on page 59.)

Note The location algorithm needs at least four P-picks to locate a solution.

All events will have at least one solution. To review this solution, click the Solutions 
tab at the top of the multi-pane panel in the Atlas window, then click the solution node 
(Figure 3-6). Until the solution has been located, the values will be zero. (If you do not 
see the Solutions tab, activate the event on the Atlas desktop by clicking on the Event 
window.)

By default, all picks will have a weight of 100%. To disable a pick, right click and 
choose Disable pick from the pop-up menu. 

3.5  Locate solutions
Atlas uses Hypoinverse, a location program developed by the United States Geological 
Survey (USGS). If you have at least four picks and your Hypoinverse configuration 
files are complete, you can locate the solution. Click the Locate solutions button  on 
the Atlas window toolbar. The HypoLocator Input Editor window will open, providing 
the option to edit the initial conditions before Hypoinverse runs. There are fields for 
date, time, latitude, longitude, and depth, as well as a button to set the depth to be fixed. 
If the fields are grey, they are set to Hypoinverse default values and are not editable. 
Clicking Ok, whether or not you have edited the input file, will open the Hypoinverse 
results window (Figure 3-7). 

Figure 3-6  Solutions panel for an event
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Chapter 3: A Quick Tour of Atlas
The top part of the Hypoinverse Results window shows a summary of the results. The 
first column shows calculated time, hypocenter, and magnitude of this event. The sec-
ond column shows some of the error calculations. (In this example, the error calcula-
tions are large because the data were created synthetically at random times.) The third 
column lists some miscellaneous output. The bottom part of this window shows the raw 
Hypoinverse output including the contents of the output file. The format of this output 
is explained at the Hypoinverse ftp site
ftp://clover.wr.usgs.gov/pub/ehz/klein/hyp2000/).

To see the location of the epicentre on a map, right click on the solution in the Solutions 
tab and choose Locate Solution on a Map. Or, click to highlight the solution and then 
click the Show map button  on the main toolbar.

If you would like to adjust your picks or their weights, you can leave the Hypoinverse 
Results window open, make changes to the event, then locate again. This will open a 
new results window that you can use to compare to the old one.

If you now look at the Solutions panel (Figure 3-6 on page 23), you will see a summary 
of the location just calculated. You can choose to have more than one solution by using 
the function buttons on the solutions toolbar:

Create a new solution 

Copy the currently active solution 

Copy the reference solution 

Delete a solution 

3.6  Save events and solutions
If you are now satisfied with the location results, it is time to save the event. If you had 
previously saved the event, you would just be saving the new solutions (in this tour, 

Figure 3-7  Hypoinverse results window
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Chapter 3: A Quick Tour of Atlas
you have not yet saved the event). To save, click the Save button  on the toolbar. 
This will open the Save To Data Source dialog box (Figure 3-8).

You can save to Earthworm databases with Atlas Extensions, and to SEED files. The 
dialog box will list all saveable data sources that have been defined. (Optionally, you 
can type in an Event Name if you are saving to an Earthworm database with Atlas 
extensions). To save, click Ok. The saved event will now appear in your Earthworm 
catalog (or SEED file catalog) and disappear from your Nanometrics data server cata-
log. It is initially identified by the time of the preferred solution. The event name is edit-
able for Earthworm databases only.

3.7  Refine solutions with the map utilities
You can refine a solution using the Atlas interactive map. Click on the Show map but-
ton  in the main toolbar to display a new map window for the event (Figure 3-9).

Figure 3-8  Save To Data Source dialog box

Figure 3-9  Map window
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Chapter 3: A Quick Tour of Atlas
The map window uses various symbols to represent information: The squares represent 
stations (if set to indicate first motion, stations may display as triangles), the solution 
error is represented by a red circle (not visible in this example), while the black circle, 
or where the pin is pointing to, represents the origin.

Additional information is displayed in panels: On the right side is a depth slider that 
displays the solution depth and error. At the bottom right is a legend that explains what 
each symbol means. At the bottom left is a summary of all the data shown on the map 
about the station or solution that is under the mouse pointer.

Navigating the map is very similar to navigating traces: To move the centre of the map, 
click and drag the map. To zoom in or out, right click and drag up or down on the map.

The visual settings are configurable. The first thing we’ll want to do is to display the P-
pick residuals using circles around stations: Select View from the menu and then select 
Data Settings. Click on the Add button to create a new setting. Then click on the top-
left Empty button (Figure 3-10).

This will open the Choose data to display dialog box, showing a tree containing options 
for the type of data to display on a map. Select Active Solution, then P Phase, and then 
Pick Residual (Figure 3-11). Click the Ok button.

Figure 3-10  Seismic Event Display Settings dialog box
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Chapter 3: A Quick Tour of Atlas
In the Seismic Event Display Settings dialog box, click on the drop-down list to the 
right of the P-pick Residual data type button, and select Circle (Figure 3-12). The 
default Color setting will be displayed below the data type button. Click Ok to activate 
the settings.

The circles around the station symbols represent the magnitude of the P-pick residual 
for each station (Figure 3-13). To review the picks, left click once on a station with a 
large circle. This will select the traces for that station in the main Atlas event window. 
Adjust the pick on the trace. Repeat this for each pick with a large residual. Once you 
have adjusted the picks, re-locate the solution. Repeat this process until you are satis-
fied with the solution.

If the solution itself is not in the correct place, perhaps because the location algorithm 
is finding a local minimum, you can set an initial trial solution by dragging the solution 
to a new location. (Dragging of the solution is only available if the current Hypoinverse 

Figure 3-11  Choose data to display dialog box

Figure 3-12  Set the station symbol type
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Chapter 3: A Quick Tour of Atlas
settings for trial hypocenter are configured to “Set initial conditions”. See Section 
5.4.4, “Editing general Hypoinverse settings,” on page 64.) You can also alter the ini-
tial depth and select whether to use a fixed depth, using the depth slider panel.

This quick tour has provided an overview of setting up a database and catalog structure 
to load and store event data; for editing, locating, and saving events; and for refining 
solutions. For more information on working with event data, and procedures for using 
features such as filters, event bulletins, and maps, see the chapters in Part 2, “Working 
with Atlas”.

Figure 3-13  Station with a large P-pick residual
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Part 2 Working with Atlas

• Data Sources and Catalogs

• Event Data

• Filters

• Power Spectra

• Maps





Chapter 4 Data Sources and 
Catalogs

Atlas can read events from three types of data source: Earthworm compatible data-
bases, Nanometrics data servers, and SEED files. Catalogs are necessary for listing 
events in a data source, and provide criteria on which data are sorted into categories. 
(See also Chapter 2, “Setting Up A New Installation”, for an overview of Atlas data 
storage.)

You can create and remove connections to data sources as needed, view data source 
connection properties, and create catalogs for working with various types of event data. 
This chapter contains procedures for working with data sources and catalogs.

Note Before you can save event data from a Nanometrics data source, you 
need to have a connection to a writeable data source—either an Earth-
worm database with Atlas extensions, or a SEED file.

4.1  Earthworm compatible databases
Earthworm compatible databases provide the capacity to store and retrieve events over 
a local network or an Internet connection. You can create and remove connections to 
the database, view the database properties, and unlock events.

Within the Earthworm data source, you can create and remove catalogs for located 
events and for unlocated events, update catalogs, and copy events to other data sources.

Note The Earthworm database is read-only if it does not have Atlas Extensions. 
See the “Atlas Installation and Maintenance Guide” for information on cre-
ating an Earthworm database with Atlas extensions, and for adding Atlas 
extensions to an existing Earthworm database.
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Chapter 4: Data Sources and Catalogs
4.1.1   Earthworm data source options

You can create connections to the database, view the database properties, unlock 
events, and remove connections to the database.

4.1.1.1    Create a connection to an Earthworm database
1. Right click on the Data Sources node in the Catalogs panel, and then click New 

Source in the pop-up menu (Figure 4-1).

2. In the Select Data Source dialog box, click the Earthworm tab, and then type the 
appropriate values for your system in the fields for Database name, User name, 
and user Password (Figure 4-2). These values are defined during the Atlas installa-
tion. 

3. Click Ok to create the connection to the Earthworm data source.

Once the source has been added to the Catalogs panel, it will appear under the Data 
Sources node, and a connection is made to the database.

4.1.1.2    View properties of an Earthworm database
Right click on the Earthworm database node in the Catalogs panel, and then click 
Properties in the pop-up menu.

This will display the database name and user name in the Data Source Properties mes-
sage box.

Figure 4-1  Create a New Source

Right click the Data Sources node, and click New 
Source to open the Select Data Source dialog box.

Figure 4-2  Create an Earthworm Data Source connection
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Chapter 4: Data Sources and Catalogs
4.1.1.3    Unlock Earthworm database events

Unlocking events should only be necessary if events were open when there was an 
abnormal exit of the application, or if the database was shut down while Atlas was still 
running.

1. You can unlock Earthworm database events from either the main menu or the 
Earthworm database node:

In the main menu bar, choose Tools > Unlock Events.

Right click on the Earthworm database node in the Catalogs panel, and then 
click Unlock Events in the pop-up menu.

2. In the Unlock Database Events dialog box (Figure 4-3):
a) Choose the Database where the locked events are located.
b) Type in the name of the computer that locked the events.

3. Click OK to unlock the events.

4.1.1.4    Remove an Earthworm database connection

Note Removing a data source connection does not delete the information in the 
data source, just the connection to the information.

1. Right click on the Earthworm database node, and then click Remove Source in the 
pop-up menu.

2. In the Confirm Delete Source dialog box, click Yes to delete the source connec-
tion. (To retain the data source connection, click No.)

4.1.2   Earthworm catalog options

Earthworm database catalogs can be defined to contain either unlocated events, or 
located events with a range of characteristics:

An Earthworm unlocated event catalog will contain all unlocated events for the 
source.
Earthworm located event catalogs can be defined on combinations of temporal, 
epicentre, depth, and magnitude criteria. These events are searched on the basis of 
their preferred solution.

You can create, update, modify, and remove Earthworm event catalogs. You can delete 
events from a catalog, and copy events to another data source.

Figure 4-3  Unlock Database Events dialog box
Atlas Version 1.2
User Guide

14389R5
2005-01-20 33



Chapter 4: Data Sources and Catalogs
4.1.2.1    Create an Earthworm Unlocated events catalog
1. Right click the Earthworm data source node, and then choose New Catalog in the 

pop-up menu (Figure 4-4).

2. To list all unlocated events, choose Unlocated events in the Type panel (Figure 4-
5).

3. In the Catalog Name text box, type in a name for the catalog to replace the 
Unnamed default. This is the name of the catalog as it appears on the Catalogs 
panel.

4. Click Ok to create the [name of catalog] unlocated events catalog. (To discard the 
changes, click Cancel.)

Figure 4-4  Create a new Earthworm catalog

Right click the Earthworm data source node, and 
choose New Catalog to open the Catalog dialog box.

Figure 4-5  Catalog dialog box to create Earthworm catalogs
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Chapter 4: Data Sources and Catalogs
Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.1.2.2    Create an Earthworm Located events catalog
1. Right click on the Earthworm database node, and then choose New Catalog in the 

pop-up menu (Figure 4-4 on page 34).

2. To list located events:
a) Choose Located events in the Type panel.
b) Set the criteria for events to be listed using the options in the Temporal, Epi-

center, and Other panels (Figure 4-5):

All located events: Leave all options unselected.

Events for a specific time period: In the Temporal panel use either the Start 
Time and End Time fields, or the Most Recent time period field and drop-down 
list.

The Start Time (oldest event) and End Time (most recent event) are in GMT 
time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list. The list updates when refreshed, and when Atlas is 
restarted.

Events for a specific location of the origin: In the Epicenter panel use the four 
text boxes to enter cutoffs or ranges for latitude and longitude in degrees.

Events of minimum, maximum, or ranges of depths for events: In the Other 
panel select and type in the minimum and maximum depth, in kilometres.

Events of minimum, maximum, or ranges of magnitudes for events: In the 
Other panel select and type in the minimum and maximum magnitudes.

Events of some combined criteria of time period, origin, depth, and magnitude: 
Set the options as appropriate from those listed above.

3. In the Catalog Name text box, type in a name for the catalog to replace the 
Unnamed default. This is the name of the catalog as it appears on the Catalogs 
panel.

4. Click Ok to create the [name of catalog] located events catalog. (To discard the 
changes, click Cancel.)

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.1.2.3    Update an Earthworm event catalog
Right click on the Earthworm event catalog, and then choose Refresh in the pop-
up menu. 
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Chapter 4: Data Sources and Catalogs
New events and modified existing events that meet the catalog criteria will be added to 
the catalog.

4.1.2.4    Modify an Earthworm event catalog
1. Right click on the Earthworm event catalog, and then choose Modify Catalog in 

the pop-up menu.

2. Edit the options for the time period, epicentre, depth, and magnitude as required to 
reflect the new selection criteria for the catalog. (For a description of the options, 
see Section 4.1.2.2 step 2b.)

3. Click Ok to save the changes to the catalog. (To discard the changes, click Cancel.)

4.1.2.5    Copy events from an Earthworm event catalog
1. Right click on the catalog node, and then choose Copy all events to in the pop-up 

menu.

2. Choose the destination to copy the events in the pop-up list of data sources (Figure 
4-6). A Copying events from [source] to [destination] dialog box will show the 
progress of the copy function.

3. When the events have all been copied to the destination data source, click OK.

4.1.2.6    Delete events from an Earthworm event catalog
1. Right click on the catalog node, and then choose Delete all events.

2. In the Confirm Delete All Events dialog box, click Yes to permanently delete all 
events from the database that are listed in this catalog. (To retain the events, click 
No.)

Figure 4-6  Copy events from an Earthworm catalog

Right click the Earthworm 
catalog node, and choose a 
destination data source for the 
copied events.
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Chapter 4: Data Sources and Catalogs
4.1.2.7    Delete an Earthworm event catalog
Right click on the catalog node, and then choose Remove Catalog in the pop-up 
menu. The catalog will be removed, without prompting for confirmation.

4.2  Nanometrics data servers
A Nanometrics data server includes the data files generated by Naqs (including the 
channel, trigger, and event files), and the DataServer connection utility. Nanometrics 
data servers provide the Atlas client with access to trace data as received from seismic 
sensors—a channel represents trace data for an individual sensor. Nanometrics data 
servers can also provide access to picks and events detected automatically by Naqs (if 
Naqs is configured to do so).

You can create and remove connections to the data source and view the data source 
connection properties. You can create catalogs for channel, trigger, and event data, and 
hide events and triggers that are not currently of interest. You can work with Nanomet-
rics data servers over an Internet connection (with an IP address and firewall permis-
sions.)

Note Before you can save event data from a Nanometrics ringbuffer, there 
must be a writeable database—either an Earthworm database with Atlas 
extensions, or a SEED file—available to store the saved event data.

4.2.1   Nanometrics data source options

You can create connections to Nanometrics data servers, show previously hidden 
events and triggers, view properties of a data server connection, and remove connec-
tions to Nanometrics data servers.

4.2.1.1    Create a connection to a Nanometrics data source
1. Right click on the Data Sources node in the Catalogs panel, and then click New 

Source in the pop-up menu (see Figure 4-1 on page 32).

2. In the Select Data Source dialog box (Figure 4-7), click the Nanometrics tab, and 
then type the appropriate values for your system in the fields for Host, Port, User 
name, and Password. 
• Host is the name or IP address of the computer running the Nanometrics 

DataServer.
• Port is defined in the DataServer configuration file; it is typically 28002.
• User name and Password are defined in the DataServer configuration file.

3. Click Ok to add the data source to the Catalogs panel tree.
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Chapter 4: Data Sources and Catalogs
Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.2.1.2    Show hidden events and triggers
Right click on the Nanometrics data server node, and then choose Show hidden 
events & triggers in the pop-up menu. (See also Section 4.2.2.4, “Nanometrics cat-
alog hidden list,” on page 43.)

4.2.1.3    View properties of a Nanometrics data server connection
Right click on the Nanometrics data server node in the Catalogs panel, and then 
choose Properties in the pop-up menu.

This will display the connection properties in the Data Source Properties message box.

4.2.1.4    Remove a Nanometrics data server connection

Note Removing a data source connection does not delete the information in the 
data source, just the connection to the information.

1. Right click on the Nanometrics data server node, and then choose Remove Source 
in the pop-up menu.

2. In the Confirm Delete Source dialog box, click Yes to delete the data source con-
nection. (To retain the data source connection, click No.)

4.2.2   Nanometrics data server catalog options

You can create three types of data server catalogs:
Channel catalogs
Nanometrics event catalogs
Trigger catalogs

Triggers and events that are not of current interest can be moved to catalog hidden lists.

4.2.2.1    Channel catalog options

Channel catalogs display a list of available channels of trace data. You can create, mod-
ify, and delete channel catalogs.

Figure 4-7  Create a Nanometrics data server connection
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Chapter 4: Data Sources and Catalogs
4.2.2.1.1    Create a channel catalog

1. Right click on the Nanometrics data server node, and then choose New Catalog in 
the pop-up menu (Figure 4-8).

2. In the Channels Shown text box, specify which channels will be shown in this cat-
alog.
The text box should have three characters based on the channel names requested, 
using * as a wildcard. For example, to get all vertical channels, use **Z, assuming 
that the vertical channel names end with Z. If the text box contains fewer than 
three letters, Atlas assumes that the ending letters are asterisks. For example, if the 
text is just H, then Atlas reads this as H**. This feature is not case sensitive.

3. In the Instruments drop-down lists, specify which channels to display based on the 
instrument model type and serial number.
• The Model type list allows you to choose the model type of instruments to list. 

Selecting All will include all model types. 
• The Instruments list allows you to limit channels to specific serial numbers of a 

selected model type. Only the serial numbers associated with the model type 
chosen will be included. A selection of All will include all the serial numbers 
of the selected model type.

4. In the Catalog Name text box, type in a name for the catalog. This is the name of 
the catalog as it appears on the Catalogs panel.

5. Click Ok to create the channel catalog. (To discard the changes, click Cancel.)

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.2.2.1.2    Modify a channel catalog

1. Right click on the catalog node, and then click Modify Catalog in the pop-up 
menu.

2. Edit the options for Channels Shown, Instruments, and Catalog Name as required 
to reflect the new selection criteria for the catalog.
• For Channels Shown, the text box should have three characters based on the 

channel names requested, using * as a wildcard. For example, to get all vertical 
channels, use **Z, assuming that the vertical channel names end with Z. If the 

Figure 4-8  Create a catalog for a Nanometrics data source

Right click the Nanometrics data source node, and click 
New Catalog to open the Catalog dialog box.
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Chapter 4: Data Sources and Catalogs
text box contains fewer than three letters, Atlas assumes that the ending letters 
are asterisks. For example, if the text is just H, then Atlas reads this as H**. 
This feature is not case sensitive.

• For Instruments:
The Model type list allows you to choose the model type of instruments to 
list. Selecting All will include all model types. 
The Instruments list allows you to limit channels to specific serial numbers 
of a selected model type. Only the serial numbers associated with the model 
type chosen will be included. A selection of All will include all the serial 
numbers of the selected model type.

3. Click Ok to save the changes to the catalog. (To discard the changes, click Cancel.)

4.2.2.1.3    Delete a channel catalog

Right click on the channel catalog, and then choose Delete Catalog in the pop-up 
menu. The catalog will be removed, without prompting for confirmation.

4.2.2.2    Nanometrics event catalog options

Nanometrics event catalogs list events that have been detected automatically by the 
Nanometrics data servers. You can create Nanometrics event catalogs, update the list 
of events in a catalog, and modify event catalogs. You can copy events to another data 
source, hide events not currently of interest, and remove event catalogs.

Caution All trace data and triggers are reloaded from the ringbuffers when an 
event is opened. Therefore, once old trace data are overwritten in the 
ringbuffers, events will load blank traces. Save important events to a 
writeable data source (an Earthworm database with Atlas Extensions 
or a SEED file) before data are overwritten. 

4.2.2.2.1    Create a Nanometrics event catalog

1. Right click on the Nanometrics data server node, and then choose New Catalog in 
the pop-up menu (Figure 4-8 on page 39).

2. Click the Event tab.

3. Set the criteria for events to be listed in the Nanometrics event catalog:

All events for any time period and all amplitudes: Leave all options unselected.

Events for a time period: Use either the Start Time and End Time fields, or the 
Most Recent time period field and drop-down list.

The Start Time (oldest event) and End Time (most recent event) options are 
in GMT time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list.

Events of a minimum amplitude for a defined time period: Type the limit value 
in the Minimum Amplitude field.
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4. In the Catalog Name text box, type in a name for the catalog. This is the name of 
the catalog as it appears on the Catalogs panel.

5. Click Ok to create the Nanometrics event catalog, or click Cancel to discard the 
changes.

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.2.2.2.2    Update a Nanometrics event catalog

Right click on the Nanometrics event catalog, and then click Refresh in the pop-up 
menu.

New events and existing modified events that meet the catalog criteria, and are not cur-
rently on the hidden list, will be added to the catalog.

4.2.2.2.3    Modify a Nanometrics event catalog

1. Right click on the Nanometrics event catalog, and then choose Modify Catalog in 
the pop-up menu.

2. Edit the options for the time period and amplitude as required to reflect the new 
selection criteria for the catalog:

All events for any time period and all amplitudes: Leave all options unselected.

Events for a time period: Use either the Start Time and End Time fields, or the 
Most Recent time period field and drop-down list.

The Start Time (oldest event) and End Time (most recent event) options are 
in GMT time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list.

Events of a minimum amplitude for a defined time period: Type the limit value 
in the Minimum Amplitude field.

3. Click Ok to save the changes to the catalog. (To discard the changes, click Cancel.)

4.2.2.2.4    Copy events from a Nanometrics event catalog

1. Right click on the catalog node. 

2. In the pop-up menu, choose Copy all events to.

3. In the pop-up list of data sources choose the destination to copy the events (Figure 
4-6 on page 36). A Copying events from [source] to [destination] dialog box will 
show the progress of the copy function.

4. When the events have all been copied to the destination data source, click OK.
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4.2.2.2.5    Hide events

You can hide single events or all events in a Nanometrics event catalog.

To hide a single event, right click on the [event], and in the pop-up menu choose 
Hide event.

To hide all events in a catalog, right click on the [event catalog], and in the pop-up 
menu choose Hide all events in catalog.

4.2.2.2.6    Clear a Nanometrics event catalog

You can clear a Nanometrics event catalog either by moving the events to the hidden 
list, or by saving all events to another database that has a catalog defined to accept the 
events.

1. Right click on the event catalog.

2. In the pop-up menu, click either Hide all events in catalog, or Save all events to 
[data source name].

4.2.2.2.7    Delete a Nanometrics event catalog

Right click on the event catalog, and then in the pop-up menu choose Delete Cata-
log. The catalog will be removed, without prompting for confirmation.

4.2.2.3    Trigger catalog options

Trigger catalogs list picks from Nanometrics data servers. (The triggers are detected 
automatically by Nanometrics Naqs. Individual channels may experience spikes and 
generate triggers; when enough channels trigger within a short enough time space, 
events are generated.) Only the trigger times are listed in a trigger catalog.

Note Trace data are reloaded from the data ringbuffer files every time the trig-
ger is opened. Therefore as older trace data are overwritten in the ring-
buffers, triggers will load only blank traces in Atlas.

You can create, modify, and update trigger catalogs. You can hide the list of triggers in 
a catalog, and delete trigger catalogs.

4.2.2.3.1    Create a trigger catalog

1. Right click on the Nanometrics data server node, and then choose New Catalog in 
the pop-up menu (Figure 4-8 on page 39).

2. Click the Trigger tab.

3. Set the criteria for triggers to be listed in the Nanometrics event catalog:

All possible triggers: Leave all options unselected.

Triggers for a specific time period: Use either the Start Time and End Time 
fields, or the Most Recent time period field and drop-down list.

The Start Time (oldest trigger) and End Time (most recent trigger) options 
are in GMT time.
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The Most Recent option will list all triggers that occurred in the defined 
time period. For example, to list all triggers for the last five days, click on 
the checkbox beside Most Recent, type 5 in the text box, and choose days 
from the drop-down list.

Triggers for a specific channel and time period: Select the channel from the 
Channels drop-down list.

4. In the Catalog Name text box, type in a name for the catalog. This is the name of 
the catalog as it appears on the Catalogs panel.

5. Click Ok to add the trigger catalog. (To discard the changes, click Cancel.)

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a warning will be displayed.

4.2.2.3.2    Modify a trigger catalog

1. Right click on the trigger catalog, and then choose Modify Catalog in the pop-up 
menu.

2. Edit the options for the time period and channel as required to reflect the new 
selection criteria for the catalog. (See Section 4.2.2.3.1, “Create a trigger catalog” 
for a description of the options.)

3. Click Ok to save the changes to the catalog. (To discard the changes, click Cancel.)

4.2.2.3.3    Update a trigger catalog

Right click on the catalog node, and then choose Refresh in the pop-up menu.

New triggers and existing modified triggers that meet the catalog criteria, and are not 
on a hidden list, will be added to the catalog.

4.2.2.3.4    Hide triggers

You can hide single triggers, and all triggers in a catalog.

To hide a trigger, right click on the [trigger node], and then choose Hide trigger in 
the pop-up menu.

To hide all triggers in a catalog, right click on the [trigger catalog node], and then 
choose Hide all events in catalog in the pop-up menu.

4.2.2.3.5    Delete a trigger catalog

Right click on the catalog node, and then choose Delete Catalog in the pop-up 
menu. The catalog will be removed, without prompting for confirmation.

4.2.2.4    Nanometrics catalog hidden list

The Nanometrics catalog hidden list helps manage data by hiding triggers and events 
that are not currently of interest, and by minimising duplication of lists of trigger and 
event data.
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4.2.2.4.1    Move items to the hidden list

You can move data to the Nanometrics catalog hidden list in three ways:
Save data from a Nanometrics data server catalog to another data source. The data 
in the original catalog is moved from the catalog to the hidden list, as well as to the 
destination source.
Hide all triggers or events in a catalog.
Hide single triggers or events.

See also Section 4.2.2.3.4, “Hide triggers,” on page 43 and Section 4.2.2.2.5, “Hide 
events,” on page 42.

4.2.2.4.2    Reveal hidden items (clear the hidden list)

The Nanometrics catalog hidden list cannot be viewed, but you can move data back into 
viewable catalogs by clearing the hidden list.

Right click on the Nanometrics data server node, and then choose Clear hidden list 
in the pop-up menu.

Nanometrics event, trigger, and channel data that were moved to the hidden list by any 
method will be moved back to the appropriate Nanometrics catalogs.

4.3  SEED files
SEED file data can be imported and exported over a local network connection. You can 
create and remove connections to existing SEED files, create a new SEED file, and 
view the connection properties of SEED files. Within a SEED data source, you can cre-
ate event catalogs.

4.3.1   SEED file data source options

This section contains procedures for working with SEED file data sources.

4.3.1.1    Create a connection to an existing SEED file
1. Right click on the Data Sources node in the Catalogs panel, and then choose New 

Source in the pop-up menu (see Figure 4-1 on page 32).

2. In the Select Data Source dialog box, click the SEED tab (Figure 4-9).

Figure 4-9  Create a connection to a SEED file
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3. Type in the path and file name of the SEED file, or click the Browse button to 
search the file system.

4. Click Ok to add the SEED file data source to the Catalogs panel tree.

Atlas will open a connection with the data source and attempt to gather data that meet 
the criteria. If the data source is unavailable, or if some of the database connect settings 
are incorrect, a dialog box will open, providing the option to create a new SEED source.

4.3.1.2    Create a new SEED file
1. Right click on the Databases node in the Catalogs panel, and then choose New 

Source in the pop-up menu (see Figure 4-1 on page 32).

2. In the Select Database dialog box, click the SEED tab, and type the new file name 
(Figure 4-9).

3. Click OK.

4. In the Create New Seed File dialog box, click Yes to create the new SEED file.

The new SEED file will appear under the Data Sources node. No event has been added 
to the file at this point, and the SEED file will not be visible in the computer file system 
until an event has been added.

To add events to the file, and to make the file visible in the computer file system, 
copy events from an existing data source to the new SEED file from within Atlas. 
See, for example, Section 4.1.2.5, “Copy events from an Earthworm event cata-
log,” on page 36.

4.3.1.3    Remove a SEED file connection
1. Right click on the SEED file node, and then choose Remove Source in the pop-up 

menu.

2. In the Confirm Delete Source dialog box, click Yes to delete the connection to the 
SEED file. (To retain the connection, click No.)

This just removes the Atlas connection to the SEED file, it does not remove the SEED 
file from the file system.

4.3.2   SEED file catalog options

SEED file catalogs can be defined to contain events for a given time period, or all 
events if a time period is not specified. Events are exported from SEED files, or saved 
from Earthworm databases or Nanometrics data servers. (See Section 2.2.1.3.1 on page 
10 for information on SEED file limitations.) By default, a SEED catalog containing 
all events is created when a data source is defined.

You can create, modify, and remove a SEED event catalog. You can update the list of 
events, delete events, and copy events to another data source.
Atlas Version 1.2
User Guide

14389R5
2005-01-20 45



Chapter 4: Data Sources and Catalogs
4.3.2.1    Create a SEED event catalog
1. Right click on the SEED file node, and then choose New Catalog in the pop-up 

menu.

2. Set the criteria for events to be listed in the SEED event catalog:

All events: Leave all options unselected.

Events for a specific time period: Use either the Start Time and End Time 
fields, or the Most Recent time period field and drop-down list:

The Start Time (oldest event) and End Time (most recent event) options are 
in GMT time.
The Most Recent option will list all events that occurred in the defined time 
period. For example, to list all events in the last five days, click on the 
checkbox beside Most Recent, type 5 in the text box, and choose days from 
the drop-down list.

3. In the Catalog Name text box, type in a name for the catalog. This is the name of 
the catalog as it appears on the Catalogs panel.

4. Click Ok to create the SEED event catalog. (To discard the changes, click Cancel.)

4.3.2.2    Update a SEED event catalog
Right click on the catalog node, and then choose Refresh in the pop-up menu.

New events and existing modified events that meet the catalog criteria will be added to 
the list.

4.3.2.3    Clear a SEED event catalog

You can clear a SEED event catalog by deleting events. All instances of the events will 
be deleted from all catalogs for the SEED file.

1. Right click on the catalog node, and then choose Delete all events in catalog in the 
pop-up menu.

2. In the Confirm Delete All Events dialog box, click Yes to delete all events. (To 
cancel the action, click No.)

4.3.2.4    Modify a SEED event catalog
1. Right click on the SEED catalog, and then choose Modify Catalog in the pop-up 

menu.

2. Edit the options for the time period as required to reflect the new selection criteria 
for the catalog. (See Section 4.3.2.1 on page 46 for a description of the options.)

3. Click Ok to save the changes to the catalog. (To discard the changes, click Cancel.)

4.3.2.5    Copy events from a SEED event catalog
1. Right click on the catalog node, and then choose Copy all events to in the pop-up 

menu.
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2. Select the destination to copy the events in the pop-up list of data sources (Figure 
4-6). A Copying events from [source] to [destination] dialog box will show the 
progress of the copy function.

3. When the events have all been copied to the destination data source, click OK.

4.3.2.6    Delete a SEED event catalog
Right click on the catalog node, and then choose Delete Catalog in the pop-up 
menu. The catalog will be removed, without prompting for confirmation.
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Chapter 5 Event Data

Atlas can be used to load, save, and copy packages of seismic data (events), locate and 
edit solutions, and annotate events. Some of the options for working with event data 
depend on the data source used—Earthworm compatible database, SEED file, or Nan-
ometrics data server. This chapter contains basic procedures for working with event 
data to locate and edit solutions.

5.1  Data loading options
Note A data source and catalog structure must be created before data can be 

loaded in Atlas. See Section 2.3, “Set up a new installation of Atlas,” on 
page 12.

This section lists procedures for loading data into new events and into existing events. 
You can load events from any data source, and load channel and trigger data from Nan-
ometrics data server catalogs.

5.1.1   Load extra trace data

You can set the amount of trace data to load for new events from Nanometrics data 
servers.

1. Open the event options: Tools > Customize – events (Figure 5-1).

2. In the Before event/trigger and After event/trigger fields, type in the number of 
seconds of extra trace data to load.

Figure 5-1  Open Customize options
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5.1.2   Load an existing event

You can load events with either the File menu or a catalog.

5.1.2.1    Load an existing event using the File menu
In the File menu, choose the [event name] in the list of recently accessed events 
(Figure 5-2).

5.1.2.2    Load an existing event using a catalog
1. Click to open nodes in the catalog tree to see the event you want to use (Figure 5-

3): Data Sources > [data source] > [event catalog].

2. Double click on the [event name], or right click on the [event name] and select 
Open Event from the pop-up menu.

5.1.3   Load channel data in a new event
1. Click to open nodes in the catalog tree to see the channel you want to use (Figure 

5-4): Data Sources > [Nanometrics data source] > [channel catalog]

2. Open a channel by either of these methods:

Right click on the [channel name] and choose Open in new event.

Click anywhere on the Event desktop to deselect all open events, and then dou-
ble click on the [channel name].

Figure 5-2  Load a recently accessed event

Figure 5-3  Open nodes in the catalog tree

Click the key icons to toggle the tree nodes to be open or 
closed; for example, to see the list of events in an event 
catalog.
Atlas Version 1.2
User Guide50 14389R5

2005-01-20



Chapter 5: Event Data
Atlas will search for available data for the channel. The Enter Time Period for 
Channel dialog box will open (Figure 5-5), providing the option to load trace data 
from the channel into a new event.

Note There are no programmed limits as to how much data can be retrieved, 
but large amounts of data may take a very long time to load and may 
exceed the memory limits of your machine.

3. Enter the time period for the data:
a) Start time: Type in the date and start time; these are in Greenwich Standard 

Time.
b) Duration: Type in the duration, and select an appropriate unit from the drop-

down list.

4. Click Ok. (To discard the changes, click Cancel.)

If trace data are available for the time period, a new event window will open containing 
one trace with the specified start time and duration.

5.1.4   Add channel data to an existing event

You can add all traces from a source, and add selected trace data.

5.1.4.1    Add all traces from a source
Right click on the trace, and in the pop-up menu choose Add all traces from [data 
source].

Figure 5-4  Load a channel from the catalog tree

Figure 5-5  Enter Time Period for Channel dialog box
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5.1.4.2    Add selected trace data
1. Ensure that the event you want to use is open and selected on the Event desktop.

2. Click to open nodes in the catalog tree to see the channel you want to use (Figure 
5-3 on page 50): Data Sources > [Nanometrics data source] > [channel catalog].

3. Double click on the [channel name]. 

Atlas will attempt to load the trace data from the channel. If trace data are available for 
the time period, the channel will automatically be added to the event with trace data for 
the time period of the event. 

5.1.5   Export an event to Y files

Y-files are similar to public format X-files, except that data is decompressed into 32-
bit binary integers. You can export events into Y-files.

1. Ensure that the event you want to use is open and selected on the Event desktop.

2. In the Event menu, choose Export to Y Files, type or browse for the path to save 
the Y-files for the event, and then click Export to export the event.

5.1.6   Load trigger data in a new event
1. Click to open nodes in the catalog tree to see the trigger you want to use (Figure 5-

3 on page 50): Data Sources > [Nanometrics data source] > [trigger catalog].

2. Open a trigger by either of these methods:

Right click on the [trigger name] and choose Open in new event.

Click anywhere on the Event desktop to deselect all open events, and then dou-
ble click on the [trigger name].

Atlas will attempt to load the trace data from the channel. Triggers detected within this 
time period will be loaded in a new event, with a pick at the start of the anomaly. If 
some or all of the data are unavailable, the trace panel may be partially or entirely 
blank.

5.1.7   Add trigger data to an existing event

You can add all triggers from a source, and add selected trigger data.

Figure 5-6  Export to Y Files
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5.1.7.1    Add all triggers from a source
Right click on the trace, and in the pop-up menu choose Add all traces with trig-
gers from [data source].

5.1.7.2    Add selected trigger data
1. Ensure that the event you want to use is open and selected on the Event desktop.

2. Click to open nodes in the catalog tree to see the trigger you want to use (Figure 5-
3 on page 50): Databases > [Nanometrics data source] > [catalog].

3. Double click on the channel node.

Atlas will attempt to load the trace data from the channel. The trace trigger will be 
added to the event, with a pick at the start of the anomaly.

5.1.8   Rename an event

You can rename events in an Earthworm database with Atlas Extensions.

Click on the highlighted event node, type in a new name, and press Enter to accept 
the changes. (To discard the changes, click on a node outside the selected event 
name.)

5.2  Event save and copy options
Table 5-1 lists options for saving and copying events.

Table 5-1  Options for saving and copying events

Option Description

Save Save the event that is currently open and selected. If it is a read-only 
data source, this option will act as Save As if there is a writeable data 
source defined.

Click the Save button  on the main toolbar.
Choose Yes in the Save dialog box when closing Atlas or closing an 
event, where the event has changed.

Save As Save [the event currently open and selected] as another event, select Save 
As in the File menu.

Save All Save all open events that have been changed before exiting Atlas, 
select Save All in the File menu.
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5.3  Solution options
An event is located by creating a solution. New solutions can be located, for example 
after adding or editing data, and multiple solutions can be stored for the event.

You can refine solutions using options variously available through map objects, pop-
up menus, and the solution toolbar (Figure 5-7). Procedures for working with solutions, 
using these various options, are described in the current section, in Section 5.4, “Solu-
tion editing options”, and in Chapter 8, “Maps”.

Copy all events to Save all events from a catalog in one data source to another data 
source, either an Earthworm database with Atlas extensions or a SEED 
file. (For Nanometrics data sources, copied events are also moved to 
the hidden list.) Select the Copy all events to option in the data source 
event catalog menu.
For example:

Copy event to Save an event from a catalog in one data source to another data 
source, either an Earthworm database with Atlas extensions or a SEED 
file. (For Nanometrics data servers, the copied event is also moved to 
the hidden list.) Select the Copy event to option in the event menu.
For example:

Table 5-1  Options for saving and copying events (Continued)

Option Description
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The Solutions panel (Figure 5-8) displays and helps manage all solutions that are part 
of a currently active event. An event must be open and selected for the Solutions panel 
to be accessible. Each event can have more than one solution, with the preferred solu-
tion determining the overall characteristics of the event. The name, time, and location 
of an event are those of its preferred solution.

A solution will have one these four states:
Needs to be located – The solution has changed since it was last located, indicated 
by the preceding symbol [l]. It must be relocated for its origin to reflect the new 
information.
Preferred – The (located) solution is the preferred solution, indicated by the pre-
ceding symbol [p].
Preferred and Needs to be located – This status is indicated by the preceding sym-
bols [p] and [l].
Located – There is no preceding symbol to indicate a located solution.

The solution summary values are calculated and displayed each time a solution is 
located. The solution summary includes values for these parameters: 

name – Name of the solution, which is the time of the origin.
date – Date of the origin in GMT time.
time – Time of the origin in GMT time.
location – Latitude and longitude of the origin in degrees.
depth – Depth of the origin in kilometres.
magnitude – Magnitude of the event in units depending on the source (for exam-
ple, duration or peak-to-peak amplitude for Atlas-generated solutions).

Figure 5-7  Solution toolbar

Figure 5-8  Solutions panel

Unlocated solution

Preferred solution

Event title node

Reference solution summary

Solution summary
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5.3.1   Create a new solution
To create a new solution (with no picks), use either of these methods:

Right click on the event title node (Figure 5-8 on page 55), and then choose 
Create New Solution in the pop-up menu.

Click the Create new solution button  on the Solutions toolbar.

5.3.2   Locate a solution

If a solution has been located but a pick has been moved, the solution will need to be 
relocated for its time and settings to reflect the changes. Solutions that need to be relo-
cated to update their settings are displayed with the preceding symbol [l]. If there are 
at least four P-picks for the event, Atlas will invoke Hypoinverse and locate the solu-
tion.

In the Solutions panel for the event, click on the solution you want to locate, and 
then locate using either of these methods:

Click the Locate Solution button  on the Solutions toolbar.

Right click the solution node (Figure 5-9), and then choose Locate Solution in 
the Solution pop-up menu.

If Allow Hypoinverse Edits is selected in the location options, the HypoLocator 
File Editor dialog box will open. This will give you the option to edit the Hypoin-
verse file settings and the input file.
If Allow Hypoinverse Edits is not selected, Atlas will invoke Hypoinverse and 
locate the solution. A Hypoinverse Results window will display results if the Show 
Hypoinverse Results location option is selected.

Figure 5-9  Open the Solution pop-up menu

Right click a solution node to open the Solution 
pop-up menu.
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5.3.3   View Hypoinverse results

You can view the Hypoinverse results window for the solution after each locate, and at 
any time during a session.

To view results after each locate, choose Tools > Customize – location (Figure 5-1 
on page 49), and click the Show Hypoiverse Results check box to toggle to show 
results  or to not show results .

To view results at any time during a session, right click the solution node to open 
the pop-up menu, and then choose View the Hypo Display (Figure 5-9 on 
page 56). The solution must have been located during the current event session for 
this option to be available.

5.3.4   View complete solution details
Right click the solution node to open the pop-up menu, and then choose View 
Complete Solution (Figure 5-9 on page 56).

This will open a solution window showing location details and magnitudes.

5.3.5   View a solution on a map

You can view the origin of the event on a map (see also Chapter 8, “Maps” for infor-
mation on refining solutions using map utilities).

To display the origin of the event, use either of these methods:

Right click the solution node to open the pop-up menu, and then choose Locate 
Solution on a Map (Figure 5-9 on page 56).

Open and select the event, and then click the Show map button  in the main 
toolbar.

A new map window will open, with the view centred around the stations and epicentre 
for the event. If the map window is not centred around the event, it may be that no 
appropriate maps have been loaded, or that the current projection settings exclude the 
geographical area for the event. (See also Section 8.2.2, “Load a new map,” on page 96 
and Section 8.3.6, “Change the map projection,” on page 101.)

5.3.6   Set a preferred solution

Note The solution must be located before it can be set as the preferred solution.

Right click the solution node to open the pop-up menu, and then choose Set As 
Preferred Solution (Figure 5-9 on page 56).

5.3.7   Set a reference solution

The Reference solution is a snapshot of a solution in time and provides a reference 
point when making changes. It does not get saved with the event and is initially set to 
the preferred solution when the event is opened. Reference solution picks appear on the 
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traces as grey lines with grey bases.The Reference solution panel displays the reference 
solution details (Figure 5-8 on page 55).

To set the current solution as the reference solution, use either of these methods:

Right click the solution node to open the pop-up menu, and then choose Set As 
Reference Solution (Figure 5-9 on page 56).

Click the Set reference solution button  on the Solutions toolbar.

5.3.8   Copy the reference solution

Copying a reference solution will create an identical copy of the reference solution and 
add it to the event.

To make a copy of the reference solution, click the Copy reference solution button 

 on the Solutions toolbar.

5.3.9   Copy a solution

Copying a solution will create an identical copy of the solution and add it to the event. 
This is recommended if the original solution should be preserved.

To make a copy of the currently active solution, use either of these methods:

Right click the solution node to open the pop-up menu, and then choose Copy 
Solution (Figure 5-9 on page 56).

Click the Copy solution button  on the Solutions toolbar.

5.3.10   View a different solution for the event

The active solution is displayed as the highlighted solution node, and as the solution 
name at the top of the Solution drop-down list (Figure 5-10).

To select a different solution as the active solution, use either of these methods:

Click on the solution node.

Click on the solution drop-down list and click on the name of the new solution.

All picks displayed on the current event will reflect the new solution.

Figure 5-10  Select a different solution

Select a different solution with either the 
drop-down list or the node.
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5.3.11   Rename a solution

In an Earthworm database with Atlas extensions, you can rename solutions.

Click on the highlighted solution node, type in a new name, and then press Enter to 
accept the changes. (To discard the changes, do not press Enter: Click on any other 
node in the solutions panel.)

5.3.12   Create or edit a solution comment

You can add comments to solutions, and edit existing comments.

1. In the Solution toolbar click the edit solution button , and then type or edit 
comments in the event comment dialog box.

2. To place the comment in memory, click Ok. The comment is not saved to the data-
base until the event is saved. (To close the dialog box without editing the com-
ment, click Cancel.)

5.3.13   Delete a solution

Note A preferred solution cannot be deleted until another solution is set as the 
preferred solution.

To delete a solution, use either of these methods (this will delete the solution from 
the event without prompting for confirmation):

Right click the solution node to open the pop-up menu, and then choose 
Remove Solution (Figure 5-9 on page 56).

Click the Delete currently active solution button  on the Solutions toolbar.

5.4  Solution editing options
Caution Editing an original solution will cause it to be recalculated before sav-

ing and will overwrite the original solution. To preserve the original 
solution information, make a copy of the solution before editing the 
original (see Section 5.3.9, “Copy a solution,” on page 58).

You can edit solutions. Options include:
Change the view of a trace (for example, zoom in on the trace).
Add new phase picks, amplitude picks, and coda durations.
Edit existing picks and durations.

5.4.1   Changing the view of a trace

You can change the view of main, pick, and zoom traces by using the mouse or the 
Event window toolbar buttons. Figure 5-11 shows the event window trace panels and 
toolbars.
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The horizontal toolbar contains two sets of buttons—Time axis and Y-axis. Time axis 
buttons allow zooming in and out on the time scale of the trace. Y-axis buttons allow 
zooming in and out on the amplitude of the trace. The set of toolbars on the left operates 
on all pick traces, while the set on the right operates on all main traces. The rulers below 
the toolbar display the time period for the pick and main traces. The vertical rulers show 
the amplitude of the trace.

The vertical toolbar is a Y-axis toolbar that allows zooming in and out on the amplitude 
of the trace for one channel. 

5.4.1.1    Zoom the time width displayed

You can zoom the time width displayed of the zoom, pick, and main traces, using either 
the mouse or the time axis buttons.

With the mouse, right click and drag up or down on the trace to zoom the time 
width displayed of the trace at the mouse location.

On the time axis toolbar, click  to decrease the time width displayed, click  

to increase the time width displayed, and click  to reset to the default time 
width.

5.4.1.2    Zoom the amplitude range displayed

You can zoom the amplitude range displayed of the zoom, pick, and main traces.

On the Y axis toolbar, click  to decrease the amplitude displayed, click  to 

increase the amplitude displayed, and click  to reset to the default amplitude.

5.4.1.3    Change the DC offset

You can change the DC (Y-axis) offset of the zoom, pick, and main traces.

Click and drag up or down on the trace to change the DC offset of the trace.

Figure 5-11  Event window trace panels and toolbars
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5.4.1.4    Change the start time of the view

You can change the start time for the view of the zoom and main traces. (Since pick 
traces are centred on a pick, only the DC offset can be changed for pick traces.)

Click and drag left or right on the trace to change the start time for the view of the 
trace.

5.4.2   Picking traces

You can add phase picks, coda durations, and amplitude picks to traces.

Atlas currently supports two pick weights, 0% and 100%:
Picks with 0% weight (inactive or disabled picks) will not be used when locating a 
solution.
Picks with 100% weight (active or enabled picks) are used when locating solu-
tions.

There are other weight factors that, when combined, determine the total weight of the 
pick when used in Hypoinverse. These weights are based on channel weights as well 
as distance and time from the origin of the event. See Appendix A, “Hypoinverse”, for 
more information.

Note Zooming the view of the trace before working with picks can make posi-
tioning the pick easier; see Section 5.4.1, “Changing the view of a trace,” 
on page 59.

5.4.2.1    Add a phase pick to a trace

You can add phase picks to a trace by using the mouse as described in this procedure, 
or using the Pick Editor dialog box (see Section 5.4.3.2.1, “Edit picks,” on page 63).

1. Select the appropriate phase pick tool—either P  or S —on the Trace tools 
toolbar. All Pick traces will centre around existing picks of the selected type. 
Traces with no picks of the selected type will centre around the location of the 
mouse pointer on the Main trace.

2. On either the main trace or zoom trace, move the mouse pointer to the new pick 
location.

3. Shift-click to add a new phase pick to the trace at the mouse pointer location.

If the trace already had a phase pick of this type, the pick will be moved to the new loca-
tion.

5.4.2.2    Add a duration phase to a trace

You can add a duration phase by using the mouse as described in this procedure, or 
using the Pick Editor dialog box (see Section 5.4.3.2.1, “Edit picks,” on page 63).

1. Select the duration phase pick tool  on the Trace tools toolbar. All pick traces 
will centre around existing duration phase picks. Traces with no picks will centre 
around the location of the mouse pointer on the Main trace.
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2. On either the main trace or zoom trace, move the mouse pointer to the new pick 
location.

3. Shift-click to add a new duration phase pick to the trace at the mouse pointer loca-
tion, or to move an existing pick to the new location.

5.4.2.3    Add amplitude picks to a trace

You can add amplitude picks by using the mouse as described in this procedure, or 
using the Amplitude Editor dialog box (see Section 5.4.3.2.2, “Edit amplitudes,” on 
page 64).

Note For information on filtering out instrument response and applying a Wood 
Anderson instrument simulation filter prior to calculating amplitude mag-
nitude, see Section 6.1, “Creating and applying filters,” on page 71 and 
Section 6.2.4, “Instrument Simulation filter,” on page 82.

1. Select the amplitude pick tool  from the Trace tools toolbar. All Pick traces will 
centre around existing amplitude picks. Traces with no amplitude picks will centre 
around the location of the mouse on the Main trace.

2. Move the mouse pointer over the main trace or the zoom trace to the target loca-
tion for one of the amplitude picks.

3. Shift-click to add a new pair of amplitude pick markers at the mouse pointer loca-
tion.
If the trace already had an amplitude pick, one of the pick markers will be moved 
to the new location.

4. Click and drag the second amplitude pick marker to the appropriate location.

5.4.3   Modifying picks

You can toggle the weight of picks, move picks, and delete picks, using either mouse 
and menu options or pick editor tables. Pick editor tables allow precise modification of 
picks and can be used regardless of whether the picks have available trace data.

5.4.3.1    Modify picks using the mouse and menu options

Picks with available trace data can be modified using the mouse and menu options. 

Note Zooming the view of the trace before working with picks can make posi-
tioning the pick easier; see Section 5.4.1, “Changing the view of a trace,” 
on page 59.

5.4.3.1.1    Change a pick weight

Right click on the pick on the appropriate trace, and then choose the Disable [pick 
name] or Enable [pick name] option from the pop-up menu to toggle the pick 
weight.
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5.4.3.1.2    Move a pick

Either click and drag the pick to the new location, or Shift-click on the trace at the 
new location.

5.4.3.1.3    Delete a pick or a duration

Right click on the pick on the appropriate trace, and then select the Delete [pick 
name] option from the pop-up menu.

5.4.3.2    Modify picks using Edit Picks and Edit Amplitudes tables

You can modify picks using the Pick Editor and Amplitude Editor dialog boxes. The 
dialog boxes display all picks that are part of the solution, whether trace data are avail-
able or not. The information is stored in a table format.

5.4.3.2.1    Edit picks

In the Pick Editor dialog box (Figure 5-12) you can add, edit, and delete phase picks—
P-picks, S-picks, and duration phases—for the event, and toggle picks on (weight of 
100%) or off (weight of 0%). All phase picks for the solution, including those for which 
no trace data are available, are listed in the table.

1. Open the Pick Editor dialog box:

Right click on the solution name in the Solutions panel (Figure 5-9 on page 56), 
and then choose Edit Picks.

2. Add, edit, activate or deactivate, and delete picks:

Add a pick: Click New Pick, and then click in a field (for example, Phase) to 
type in the appropriate value. Time is in GMT.

Edit a pick: Click in a field (for example, Time) to type in the appropriate 
value. Time is in GMT.

Toggle a pick to be active or inactive: Click in the Use Pick checkbox. An 
active pick (weight of 100%) shows a check mark, an inactive pick (weight of 
0%) shows an empty field.

Delete a pick: Click in any field for the pick, and then click Delete Pick.

3. Click OK to accept the pick edits. (To discard the changes, click Cancel.)

Figure 5-12  Pick Editor dialog box
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5.4.3.2.2    Edit amplitudes

In the Amplitude Editor dialog box (Figure 5-13) you can add, edit, and delete ampli-
tude picks for the event, and toggle picks on (weight of 100%) or off (weight of 0%). 
All amplitude picks for the solution are listed in the table.

1. Open the Amplitude Editor dialog box:

Right click on the solution name in the Solutions panel (Figure 5-9 on page 56), 
and then choose Edit Amplitudes.

2. Add, edit, activate or deactivate, and delete amplitude picks:

Add a pick: Click New Amplitude, and then click in a text field to type in the 
appropriate value for the field. Time is in GMT.

Edit a pick: Click in a text field to type in the appropriate value for the field. 
Time is in GMT.

Toggle a pick to be active or inactive: Click in the Use Pick checkbox. An 
active pick (weight of 100%) shows a check mark, an inactive pick (weight of 
0%) shows an empty field.

Delete a pick: Click in any field for the pick, and then click Delete Amplitude.

3. Click OK to accept the amplitude pick edits. (To discard the changes, click Can-
cel.)

5.4.4   Editing general Hypoinverse settings

You can use options in the Hypoinverse Settings Editor window (Figure 5-14) to edit 
general settings that will apply to all or most location runs. Hypoinverse starts by read-
ing commands in the \user\hypinst file, which usually directs Hypoinverse to 
more commands in the \user\hypoinverse\Atlas.hyp file. The settings edi-
tor allows you to change this pattern for selected commands.

Figure 5-13  Amplitude Editor dialog box
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5.4.4.1    Allow Hypoinverse edits
1. Open the location options: Tools > Customize – location (Figure 5-1 on page 49).

2. Click the check box to toggle Allow Hypoinverse Edits to either allow edits  or 
to not allow edits .

5.4.4.2    Open the Hypoinverse Settings Editor

You can access the Hypoinverse Settings Editor either through location options, or dur-
ing a locate if Allow Hypoinverse Edits is selected in location options:

Open the location options: Tools > Customize – location (Figure 5-1 on page 49), 
and then click Edit Hypoinverse Settings.

If Allow Hypoinverse Edits is selected in location options, then locating a solution 
will open the HypoLocator File Editor (Figure 5-15) with the option to Edit Hypo-
Settings.

Figure 5-14  Hypoinverse Settings Editor
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5.4.4.3    Set files that Hypoinverse will use

Options in the Hypoinverse File Chooser panel allow you to set which command, sta-
tion, and crustal model files Hypoinverse will use.

5.4.4.3.1    Set the command file

The command file contains all the commands that allow Hypoinverse to run and deter-
mines how several calculations are carried out. Changing the command file requires 
that you also set up the rest of Hypoinverse. In addition, any other changes made in the 
Hypoinverse Settings Editor window will be ignored by Hypoinverse.

To set a new file, either type the file path in the Command File field, or click the 
Browse button to set the file from a browse window.

To reset to the default command file Atlas.hyp, click the Default button.

5.4.4.3.2    Set the station file

You can use the default station file AtlasStations.hinv, or you can specify a 
different station file for Hypoinverse to read.

The station file contains details about the stations and channels that are used, such as 
location, latitude, longitude, delays, and corrections. If the input file contains a channel 
that is not in the station file, that channel information will be ignored.

Atlas creates the station file AtlasStations.hinv each time Hypoinverse is 
invoked. AtlasStations.hinv includes all of the stations in the file
UserStation.hinv in the same directory, as well as the stations of the solution that 
are in memory (duplicates are ignored). You may edit UserStations.hinv to 
ensure that channel settings are correct.

To set a new file, either type the file path in the Station File field, or click the 
Browse button to set the file from a browse window.

To reset to the default file AtlasStations.hinv, click the Default button.

Figure 5-15  HypoLocator File Editor
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5.4.4.3.3    Set the crustal model file

The Crustal model text field sets the file that contains information about the velocity 
model. AtlasCrustalModel.hyp is a command file that specifies which models 
apply where. Atlas is shipped with a simplified model which attempts to show how a 
crustal model can be developed. See
\user\hypoinverse\AtlasCrustalModel.hyp for more details.

To set a new file, either type the file path in the Crustal Model field, or click the 
Browse button to set the file from a browse window.

To reset to the default file AtlasCrustalModel.hyp, click the Default but-
ton.

5.4.4.4    Set weighting parameters

The final weight of a particular pick is the result of the three weighting parameters 
listed below and weights in station and delay files. These weighting parameters only 
apply to the location algorithm, not the magnitude calculations. The final weight is 
saved when the solution is saved.

Weight Codes for phase picks – Hypoinverse applies discrete weight codes for 
phase picks. The value of these codes can be adjusted by editing the four numeric 
fields in the Weight Codes section. Atlas only uses weights that are 100% or 0%, 
therefore the value from the first field is the one applied to all of the phase data. 
The weight code field can also be edited by editing the input file when locating an 
event.
Time Residual Weights – Hypoinverse applies weights based on the size of the 
time residual. Edit values in the four numeric fields to set parameters that deter-
mine the time over which the weight is 100% and 0%, as well as specifying the 
cosine taper between time residual and distance. See Hypoinverse documentation 
for details.
Distance Weights – Hypoinverse applies weights based on how far away a station 
is from the epicentre. Edit values in the four numeric fields to set parameters that 
determine the distance over which the weight is 100% and 0%, as well as specify-
ing the cosine taper between distance and time residual. See Hypoinverse docu-
mentation for details.

5.4.4.5    Set initial conditions for Hypoinverse calculations

You can set initial conditions for Hypoinverse calculations in the Hypoinverse Settings 
Editor (see Section 5.4.4.2).

5.4.4.5.1    Use the station location of the earliest pick

To set Hypoinverse to use the station location of the earliest pick as the starting 
location, select Use Default Initial Conditions in the Trial Hypocenter Settings sec-
tion. The initial time is 2 seconds before the time of the earliest pick.
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5.4.4.5.2    Use the initial time, location, and depth

To set Hypoinverse to use the initial time, location, and depth from the summary 
line of the Hypoinverse input file, select Set Initial Conditions in the Trial Hypo-
center Settings section.

Atlas will calculate the default values as if the Use Default Initial Conditions button 
were selected, but you will have the option to edit these initial conditions before locat-
ing the solution.

5.4.4.5.3    Set the trial depth

To set the trial depth, type a positive value in the Trial Depth field. The default 
depth is 7km.

5.4.4.5.4    Fix the initial depth

To fix the depth value as the initial depth for location calculation to the depth in 
the text field, select Fix Depth. 

Hypoinverse will always use this value as an initial depth unless a depth is set in the 
summary line and the Set Initial Conditions is selected.

5.4.4.6    Accept Hypoinverse setting changes
To write all changes shown on the Hypoinverse Settings Editor window, click OK. 
(To discard all changes, click Cancel all changes.)

This will edit the files hypinst and Atlas.hyp. The file hypinst will be 
changed if the main command file is changed. Atlas.hyp will be changed only in 
the interval between the lines:
* ++++++++++++++++++++++++Atlas Content++++++++++++++++++++++++

and
* ++++++++++++++++++++++++Atlas Content Ended+++++++++++++++++++

5.4.4.7    Restore default Hypoinverse settings

Note Restore Defaults is not the same as Retrieve Original Hypoinverse Setup, 
which overwrites all files (see Section 5.4.4.8).

To restore the default setting for an item, click the associated Default button.

To restore the default setting for all of the items, click Restore Defaults. (This is 
equivalent to pressing all the item Default buttons at once.) 

5.4.4.8    Reset files to the default setup

You can reset files containing the following information to the setup files shipped with 
Atlas. This will overwrite current files with the original setup information:

Command file
Crustal model
Station name file
Weighting parameters
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Trial hypocenter settings

1. Open the Hypoinverse Settings Dialog Box (see Section 5.4.4.2).

2. In the Reset Files panel, click Retrieve Original Hypoinverse Setup.

3. In the Confirm Overwrite Files dialog box, click Yes to overwrite the existing 
files. (To retain the current files, click No.)

5.5  Event bulletins and comments
Atlas provides the option to create HTML bulletins for events, and to add comments to 
events. The comments are included in the event bulletin and can also be viewed sepa-
rately from within Atlas.

5.5.1   Create an HTML event bulletin
1. In the Event menu, choose Create Bulletin (Figure 5-16).

2. In the Creating an Event Bulletin dialog box (Figure 5-17) set the bulletin options:
a) Define the location and name of the event bulletin directory, in Directory 

Name.
b) Click to select  or to deselect .options for the information that is to be 

included in the bulletin (for example, Title, Phases).
c) Click and drag the slider to set image quality for graphics such as maps and 

waveforms.

Figure 5-16  Create or view an event bulletin

Figure 5-17  Creating an Event Bulletin dialog box
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3. View or Create the bulletin:

If the bulletin directory does exist, choose an option:
Create will overwrite the existing bulletin with the new information.
View will open the bulletin index.html file, displaying all of the event 
bulletin information.

If the bulletin directory does not yet exist:
i. Click either Create or View to create a new bulletin in the specified direc-

tory.
ii. In the Directory doesn’t exist dialog box, click Yes to create the directory.
iii. Modify map information if desired, then click Ok.

4. To close the dialog box, click Exit.

5.5.2   Create or edit an event comment

In an Earthworm database with Atlas extensions, you can add comments to events and 
edit existing comments.

1. In the Event menu (Figure 5-18) click Edit Comment, and then edit comments in 
the event comment dialog box.

2. To place the comment in memory, click Ok. The comment is not saved to the data-
base until the event is saved. (To close the dialog box without editing the com-
ment, click Cancel.)

Figure 5-18  Create or edit an event comment
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Atlas provides robust methods for applying digital filters to trace data. It is designed to 
make filtering a simple process, making key information easily available and automat-
ing repetitious tasks. This chapter contains procedures for working with filters.

Single filters and groups of filters can be created and saved for immediate or future use. 
Filters or groups of filters can be applied to any trace or to all traces at once in an event. 

The types of filters that can be created in Atlas include:
Basic – S-plane and Z-plane, using either poles and zeroes or coefficients for the 
transfer function
Butterworth
Instrument deconvolution (IIR filters)
Instrument simulation
Ground motion conversion
Trend removal

6.1  Creating and applying filters
When an event is loaded, all traces will start unfiltered. Each trace has an independent 
list of applied filters (initially this list is empty), accessible from the Applied filters 
panel (Figure 6-1).

You can create filters in the saved filter groups panel, and then apply the filters indi-
vidually or as a group to one or more traces, or create filters directly for a channel in 
the Applied filter panel for the selected trace.
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6.1.1   Add a filter group

You can add filter groups to the list of saved filter groups by creating a new group, and 
by loading an existing group.

6.1.1.1    Create a new filter group
1. Right click on the Saved Filter Groups node and then choose New Filter Group in 

the pop-up menu.

2. In the Filter Group Name dialog box, type a name for the filter group.

3. Click Ok to create the group.

6.1.1.2    Load an existing filter group
1. Right click on the Saved Filter Groups node and then choose Load Filter Group in 

the pop-up menu.

2. Browse for a response file, and then select or type in the file name.

3. Click Open to load the group.

6.1.2   Create a filter

You can create a filter in the Saved Filter Groups list, and in the applied filters group 
for the trace. Filters created in the applied filters group are not saved when the event is 
closed.

Note You can save a filter from the applied filters group to a saved filter group—
drag and drop the filter into the saved filter group.

Figure 6-1  Filters panel

Click the Filters tab to open the main Filters panel.

Applied filters panel

Saved filters panel
a filter group

filters
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6.1.2.1    Create a filter in the saved filter groups list

Filters in a saved filter group are available to be applied to traces open in the current 
session, and can be applied to traces in future sessions.

1. Right click on the desired filter group in the Saved Filter Groups panel (Figure 6-
2) and then choose New Filter from the pop-up menu.

2. In the Select Filter dialog box, click to select the type of filter that you want to cre-
ate (Figure 6-3).

3. Set the filter parameters. See Section 6.2 on page 76 for descriptions of the options 
for each filter type.

4. Click Ok in the filter dialog box to create the filter.

This will add the filter to the Saved filter group.

6.1.2.2    Create a filter in the applied filters list

Filters created in the applied filters group for a trace are applied immediately to the 
selected trace, and are available to be applied to other events in the current session.

Note Filters created in the applied filters group are not saved after the event is 
closed. You can save a filter from the applied filters group for use in future 
sessions—drag and drop the filter into a saved filter group.

1. Right click on the desired channel filter group for a selected trace in the Applied 
filter panel (Figure 6-2), and then choose New Filter from the pop-up menu.

Figure 6-2  Filter group menu

Figure 6-3  Select Filter dialog box
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The first node in the applied filter panel is the name of the channel of the selected 
trace.

2. In the Select Filter dialog box, click to select the type of filter that you want to cre-
ate (Figure 6-3).

3. Set the filter parameters. See Section 6.2, “Filter options,” on page 76 for descrip-
tions of the options for each filter type.

4. Click Ok in the filter dialog box to create the filter.

As soon as the filter is created, the trace changes to its filtered state. The new filter will 
appear at the end of the applied filter group list for the channel.

6.1.3   Change the order of filters in a group

Filters are applied to a trace in the order in which they appear in the list—filters at the 
top of the list are applied first.

Click and drag filters within the group to apply them in a different order to the 
trace.

6.1.4   Rename filters and filter groups
1. Click on the name of the filter or filter group you want to rename, and click again 

to open the name for editing.

2. Type in the new name and press Enter to save the change. (Click anywhere outside 
the edit box to discard the changes.)

6.1.5   Apply existing filters

You can apply existing filters and filter groups to a trace. (To apply a new filter imme-
diately to a channel, see Section 6.1.2.2).

6.1.5.1    Apply a single filter

Note A filter cannot be applied to a trace if the filter sampling rate does not 
match that of the trace, but filters with a sampling rate of 0 can always be 
applied.

Figure 6-4  Applied filter group menu
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Applying an individual filter will add the filter to the group, with the application order 
determined by the filter position in the list. A single filter can be applied immediately 
to a trace either at the end of the filter list (that is, applied last in the sequence) or at an 
intermediate position:

To apply the filter to the trace at the end of the applied filter list, drag and drop the 
filter onto either of these targets:
• The trace, in the event window.
• The applied filter panel for the selected channel.

To apply the filter at an intermediate position in the list, drag and drop the filter 
onto a filter that is already in the list. This will apply the new filter before the sub-
sequent filters, including the target filter.

6.1.5.2    Apply a filter group

Note A filter group can only be applied to a trace if the first filter in the group can 
be applied to the trace. A filter cannot be applied to a trace if the filter sam-
pling rate does not match that of the trace, but filters with a sampling rate 
of 0 can always be applied.

Applying a filter group will replace the list of currently applied filters with the new fil-
ter group. You can apply a group to all traces in an event, or to a single trace:

To apply a filter group to all traces in the currently selected event, right click on 
the filter group you want to apply, and then select Apply to All Traces from the 
pop-up menu. If the trace can be filtered by the filter group, the trace will have the 
filter group applied to it.

To apply a filter group to the selected trace, use either of these methods:

Right click on the filter group, and then choose Apply to Trace from the pop-up 
menu.

Drag and drop the group onto the trace, or onto the applied filter group panel.

6.1.6   View and edit filter properties

You can view the properties of a filter, and edit the filter properties.

Right click on the filter name. In the pop-up menu choose Filter properties. This 
opens the filter properties dialog box for that type of filter, in which you can view 
and edit the properties.

6.1.7   Remove filters

You can remove a single filter from anywhere in the filter group, and remove all filters 
at once by applying an empty filter group.

6.1.7.1    Remove a filter
To remove a filter, right click on the filter name. Choose Delete filter in the pop-up 
menu.
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6.1.7.2    Clear an applied filter list

Applying an empty filter group can be used to clear a filter list quickly.

Create an empty filter group and apply it to the trace. (See also Section 6.1.1, “Add 
a filter group,” on page 72, and Section 6.1.5, “Apply existing filters,” on 
page 74.)

6.2  Filter options
This section provides descriptions of the options for each filter type:

Basic – S-plane and Z-plane (Section 6.2.1 on page 76)
Butterworth (Section 6.2.2 on page 81)
Instrument deconvolution (IIR filters) (Section 6.2.3 on page 82)
Instrument simulation (Section 6.2.4 on page 82)
Ground motion conversion (Section 6.2.5 on page 83)
Trend removal (Section 6.2.6 on page 84)

6.2.1   Basic filter

With the Basic filter you can create an analog S-plane or discrete Z-plane filter, using 
either poles and zeroes or coefficients for the transfer function. There are settings com-
mon to all filters, and specific options selectable under the tabbed pages in the Basic 
Filter dialog box (Figure 6-5).

Figure 6-5  Basic Filter dialog box
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6.2.1.1    Settings common to all Basic filters

6.2.1.2    Additional Basic filter settings

6.2.1.2.1    Poles and Zeroes

Select the Poles & Zeroes tab to access options for editing poles and zeroes.

Analog poles and zeroes filters are described using this transfer function:

(EQ 1)

where F(s) is evaluated at , where f is the desired frequency in hertz.

Table 6-1  Basic filter settings

Filter setting Description

Midband Gain (g) The gain of the filter at the gain frequency. Filtering a sine wave of 
amplitude 1 at the gain frequency will result in a sine wave of this 
amplitude.

Gain Frequency The frequency, in hertz, at which the filter should attain midband gain.

Input Units A string that describes the units of the input trace into the filter, such as 
M/S, V, Counts. This field is especially important for instrument 
simulation and motion filters.
• If the filter is part of a channel response list, these filters will read the 

input units of the first filter to determine the ground motion type meas-
ured.

• If the input units are one of M, M/S, M/S/S, or M/S**2, the instrument 
will be determined to measure displacement, velocity, or acceleration 
respectively.

Output Units A string that describes the units of the output trace.

Sampling Rate The required input sampling rate for this filter. If set to 0, this filter may 
be applied to any trace.

Decimation An integer greater than or equal to 1, it determines what portion of the 
results to keep. A factor of x will cause the output trace to be 1/x the 
input size. For discrete filters, decimation is applied to the numerator 
part of the transfer function only.

Delay Additional delay to apply after filtering, in seconds.
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Discrete poles and zeroes filters are described using this transfer function:

(EQ 2)

where z is evaluated on the unit circle. Zeroes are the complex ci of equations (1) and 
(2), while poles are the complex dj of equations (1) and (2).

6.2.1.2.2    Coefficient filters

Select the Coefficients tab to access options to edit coefficient filters.

Discrete coefficient filters are described using this transfer function:

(EQ 3)

where z is evaluated on the unit circle.

Analog coefficient filters are described using this transfer function:

(EQ 4)

where F(s) is evaluated at , where f is the desired frequency in hertz.

Table 6-2  Poles and zeroes options for Basic filters

Option Description

Assume Conjugates Causes conjugate poles and zeroes to be added for every pole or 
zero for which the imaginary part is not 0.

Complex Zeroes c Allows adding, editing, and deleting of the real and imaginary parts of 
each zero.

Complex Poles d Allows adding, editing, and deleting of the real and imaginary parts of 
each pole.
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Chapter 6: Filters
6.2.1.2.3    Discrete Filters

Select the Discrete tab to access options to edit discrete filters.

6.2.1.2.4    Continuous Filters

Continuous or analog filters do not have additional settings in this release.

Table 6-3  Coefficients options for Basic filters

Option Description

Numerator Symmetry Numerator coefficient symmetry to use, where:
• None – No symmetry.
• Even – Creates a filter with 2N coefficients that is symmetric 

around the middle. For example, a list of 1, 2, 4 would cre-
ate a filter with a list of 1, 2, 4, 4, 2, 1 with no symmetry.

• Odd – Creates a filter with 2N – 1 coefficients that is sym-
metric around the middle. For example, a list of 1, 2, 4 would 
create a filter with a list of 1, 2, 4, 2, 1 with no symmetry.

Numerator Coefficients C Allows adding, editing, and deleting of filter numerator 
coefficients Ci.

Denominator Coefficients D Allows adding, editing, and deleting of filter denominator 
coefficients Dj. They are not affected by the symmetry 
settings.

Table 6-4  Discrete filter additional settings

Discrete filter setting Description

Filter offset The filter centre in samples from the right edge. This is the 
coefficient number that is applied at Time 0, with higher 
coefficients applied to previous samples, while lower coefficients 
are applied to future samples. A causal filter has a value of 0.

Padding Allows selecting what should be done at the edges of the trace, 
when some numerator coefficients may be applied outside of the 
trace:
• No Padding – The results are thrown out. The length of the fil-

tered trace is truncated by the number of numerator coefficients 
minus one.

• Zero Padding – The trace is padded with zeroes as needed. The 
length of the filtered trace is the same as the length of the input 
trace.

• Average Padding – The trace is padded by the average trace 
value as needed. The length of the filtered trace is the same as 
the length of the input trace.
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6.2.1.3    Filter implementation details

Discrete coefficient filters are applied using this difference equation:

(EQ 5)

as found in most books on digital filtering.1

Analog filters are implemented using FIR filters. The frequency response of the analog 
filter is inverse Fourier transformed to obtain the impulse response. The impulse 
response then forms the coefficients of the FIR filter that simulates the analog filter. A 
suitable number of coefficients are chosen so that the impulse response is complete. 
The settings listed in Table 6-5 affect this process. You can edit these settings in the 
filter options dialog box Tools > Customize – filters (Figure 6-6).

Poles and zeroes filters are applied using their coefficient counterparts. The poles and 
zeroes are multiplied out to generate the coefficients of the transfer function for a coef-
ficient filter.

1. Such as Equation 3.1, Digital Filters, Theory and Applications, N.K.Bose, Elsevier Sci-
ence Publishing Co., Inc., 1985.

Table 6-5  Options for generating FIR filters that simulate S-plane filters

Filter setting Description

Maximum FIR size Determines the maximum number of coefficients to use when 
generating FIR filters that simulate analog filters.
The more coefficients that are used, the more accurate the result. 
However, the computational costs grow dramatically as the 
number of coefficients are increased. This is only a maximum as 
fewer coefficients may be used if the impulse response of a filter is 
still considered complete.

FIR cut-off (% of peak) Determines the level at which an impulse response is considered 
complete.
If the impulse response falls below this percentage of its peak at its 
edges, it will be considered complete.

Padding Allows selecting what should be done at the edges of the trace, 
when some numerator coefficients may be applied outside of the 
trace:
• No Padding – The results are thrown out. The length of the fil-

tered trace is truncated by the number of numerator coefficients 
minus one.

• Zero Padding – The trace is padded with zeroes as needed. The 
length of the filtered trace is the same as the length of the input 
trace.

• Average Padding – The trace is padded by the average trace 
value as needed. The length of the filtered trace is the same as 
the length of the input trace.
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Chapter 6: Filters
6.2.2   Butterworth filter

Note To create a band pass filter add a low pass and a high pass filter to the 
filter group, in any order.

This option implements a standard Butterworth filter. The Butterworth filter is imple-
mented by generating a continuous poles and zeroes filter with poles equally spaced in 
the left side of the S-plane. The number of poles equals the order of the filter, the length 
of the poles equals the corner frequency in radians, and there is an equal number of 
zeroes added if the filter is high-pass.2

Figure 6-6  Filter options dialog box

2. See page 163, Digital Filters, Theory and Applications, N.K.Bose, Elsevier Publishing 
Co., Inc., 1985.

Table 6-6  Butterworth filter settings

Setting Description

Low Pass | High Pass Select either a low pass or a high pass filter.

Order Set the order of the filter.

Corner Set the corner frequency in hertz.

Gain Set the filter gain at the corner frequency.

Figure 6-7  Butterworth Filter dialog box
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6.2.3   Inverse Instrument Response filter

The Inverse Instrument Response filter attempts to remove the instrument response 
from a trace and obtain the true ground motion. A spectral division algorithm is used 
wherein the combined channel response is inverted in the frequency plane and a FIR 
filter is generated to simulate the frequency response by taking an inverse FFT.3

The inverse instrument response is not well defined outside the passband of the instru-
ment as the signal-to-noise ratio becomes small. It is thus necessary to limit the inverse 
calculations inside the passband so as to limit noise amplification.

This filter works only for traces for which a channel response has been defined. Setting 
explicit cutoff frequencies causes the response of the inverse instrument filter to go to 
0 outside the cutoffs. Setting a waterlevel limits the absolute magnitude of the instru-
ment response to a percentage of the peak value. Since the inverse process calculates 
1/H(s) where H(s) is the instrument response, this limits the peak value of the response 
of the inverse filter outside the passband.

The filtered trace thus becomes the ground motion measured by the instrument. For 
instance, if the instrument measured velocity, the filtered trace will be the actual ground 
velocity. (See Table 6-7.)

6.2.4   Instrument Simulation filter

The Instrument Simulation filter attempts to simulate the response of another instru-
ment. It deconvolves the instrument response of a trace into ground displacement and 
then applies the instrument response of another instrument.

If the passband of the target instrument is within the passband of the original instru-
ment, the final trace will be the trace that would have been obtained by the target instru-
ment should that instrument have observed the ground motion. However, if the 

3. See page 148, Of Poles and Zeros, Frank Scherbaum, Kluwer Academic Publishers, 
1996.

Table 6-7  Inverse instrument response filter settings

Setting Description

Waterlevel (%) Sets the minimum absolute value as a percentage of peak value the 
instrument response is allowed to drop to.

Lower Cutoff (Hz) Sets the lower cutoff frequency for the inverse instrument filter.

Upper Cutoff (Hz) Sets the upper cutoff frequency for the inverse instrument filter.

Figure 6-8  Inverse Instrument Response filter dialog box
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passband of the target instrument is not completely within the passband of the source 
instrument, the frequencies outside will be lost.

This filter may only be applied to traces with a channel response. It is important that 
the input units of the first filter in the channel response be one of M, M/S, M/S/S, or 
M/S**2. This allows the simulation filter to determine the ground motion measured by 
the source instrument, thus allowing conversion to the proper output motion type. (See 
Table 6-8 for filter settings.)

6.2.5   Ground Motion Conversion filter

The ground motion conversion filter converts among different ground motion types—
displacement, velocity, and acceleration. It integrates or takes the derivative of the 
input trace as required. (See Table 6-9.)

Table 6-8  Instrument simulation filter settings

Setting Description

Target Instrument The target instrument to simulate. The target instrument list is loaded 
from all available response files in the \user\instruments directory; 
for example, WoodAnderson.rsp. New response files can be added 
and existing files can be changed as needed.

Output Motion The type of ground motion to convert to.

Waterlevel (%) Sets the minimum absolute value as a percentage of peak value the 
instrument response is allowed to drop to.

Lower Cutoff (Hz) Sets the lower cutoff frequency for the inverse instrument filter.

Upper Cutoff (Hz) Sets the upper cutoff frequency for the inverse instrument filter.

Figure 6-9  Instrument Simulation Filter dialog box

Table 6-9  Ground motion conversion filter settings

Setting Description

Input Motion Sets the motion type of the input trace. The option Obtain from Trace reads 
the input units of the channel response for the trace. If the units are M, M/S, 
M/S/S, or M/S**2, the input motion is set to displacement, velocity, and 
acceleration respectively.

Output Motion Sets the type of ground motion to convert to.
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6.2.6   Trend Removal filter

The Trend Removal filter removes the average value and/or linear trend of a trace when 
the option is selected .

6.3  Instrument Response
Instrument response is built upon the Atlas filtering system. An instrument response is 
essentially a filter group, with a start time and an end time, that represents the response 
of the instrument for a given channel.

Note Instrument response history is only available on Earthworm databases at 
the current release.

Atlas maintains a history of instrument response for each channel and provides meth-
ods for entering and updating the response. Whenever a trace is loaded, Atlas finds the 
most recent or most suitable channel response and attaches it to the trace. The instru-
ment response can then be used for instrument deconvolution, instrument simulation, 
and for determining the ground motion measured when converting among motion 
types—displacement, velocity, and acceleration.

Once an instrument response has been loaded as part of a trace, it is independent of the 
response data stored in the original data source, and can be edited for that trace. Next 
time the trace is saved, the instrument response on the target data source will be updated 
with this new response.

Figure 6-10  Ground Motion Filter dialog box

Table 6-10  Trend removal filter settings

Setting Description

Remove average Removes the average of a trace.

Remove linear trend Removes the linear trend of a trace.

Figure 6-11  Trend Filter dialog box
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6.3.1   Earthworm Instrument Response

For Earthworm databases with Atlas Extensions, instrument response history is auto-
matically updated whenever a trace is saved with a new response. After an update any 
new traces loaded from the data source will use the new response if applicable. When 
loading a trace, Atlas retrieves the most recent instrument response which has a time 
period that includes the start time of the trace.

Atlas maintains separate tables from conventional Earthworm response, which sup-
ports only analog poles and zeroes. When loading an instrument response Atlas 
retrieves the most recent response from both the Earthworm response tables and Atlas 
response tables. However, Atlas supports saving instrument response only to Atlas 
response tables.

6.3.2   Instrument Response editing options

You can edit the currently applied instrument response, and all instrument response his-
tory.

Once an instrument response has been loaded as part of a trace it is independent of the 
response data stored in the original data source, and you can edit and alter the response 
for that trace. Next time the trace is saved, the instrument response on the target data 
source will be updated with this new response. 

6.3.2.1    Edit instrument response for a trace

Note This option to edit the instrument response currently applied to a trace is 
available only if relevant instrument response is found when the trace is 
loaded.

1. Open the Instrument Response window (Figure 6-12):
a) Right click on a trace from the channel for which instrument response is to be 

edited, and then choose Instrument Response in the pop-up menu.
b) In the sub-menu, choose For Trace.

2. In the Instrument Response for trace window, right click on a node to view the 
options:
• Response node options (see Section 6.3.2.2.2 on page 87)
• Filter node options (see Section 6.3.2.2.3 on page 87)

Figure 6-12  Open the Instrument Response window

Right click the trace for the channel, choose 
Instrument Response, and then choose a specific 
Instrument Response.
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3. Edit the response using the options appropriate to your task. For example, to edit 
the time period for acquiring instrument response for the trace, choose Properties 
from the pop-up menu, edit the time period properties, and click OK to save the 
changes (Figure 6-13).

4. Click Save to save the changes to the response. (To discard the changes, click 
Close.)

6.3.2.2    Edit instrument response for a data source

This option allows you to edit all instrument response found in the data source from 
which the event was loaded.

1. Open the Instrument Response window (Figure 6-12 on page 85):
a) Right click on a trace from the channel for which instrument response is to be 

edited, and then choose Instrument Response in the pop-up menu.
b) In the sub-menu, choose History for [data source].

2. In the Instrument Response for trace window, right click on a node to view the 
options for:
• Response history (see Section 6.3.2.2.1 on page 87)
• Response (see Section 6.3.2.2.2 on page 87)
• Filters (see Section 6.3.2.2.3 on page 87)

3. Edit the response using the options appropriate to your task. For example, to load 
an instrument response for the trace, choose Load Response from the pop-up menu 
(Figure 6-14) and then browse for the response file to add.

4. Click Save to save the changes to the response history. (To discard the changes, 
click Close.)

Figure 6-13  Edit instrument response for a trace

Right click the Response node, and then 
choose Properties to edit the instrument 
response for the trace.
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6.3.2.2.1    Response history

The response history node lists all available instrument response in the data source. 
This node appears when you select the Instrument Response > History In [data source 
name]. 

To open the response history options menu (see Table 6-11), right click on the 
response history node.

6.3.2.2.2    Response

The response node lists filters that form an instrument response. This node appears 
when you select the Instrument Response > For Trace option.

The response node acts identically to that of a filter group in filtering, except it also 
includes a start time and an end time for which the response is valid. For example, 
MCM.VHZ: from 1970-01-01 to 2286-11-20. (See also Section 6.1, “Cre-
ating and applying filters,” on page 71.)

To open the response options menu (Table 6-12), right click on the instrument 
response node.

6.3.2.2.3    Filters

Filter nodes in the response window have the same properties as those of a filter group. 
(See also Section 6.1, “Creating and applying filters,” on page 71.)

Figure 6-14  Load instrument response for a data source

Right click the Response History node, and 
choose Load Response to find a response 
file to add for the trace.

Table 6-11  Response history node options

Menu option Function

New Response Creates a new instrument response for the channel.

Load Response Loads an instrument response from a response file.

Table 6-12  Response node options

Menu option Function

New Filter Adds a new filter to the response file. Only a basic or Butterworth filter 
can be added.

Properties Allows edits to the start and end time for which this response is valid.

Delete Response Deletes this instrument response from the history.
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To open the filter options menu (Table 6-13), right click on the filter node.

6.3.2.3    Limitations of Channel Response
Channel response filters can only be saved as basic filters. For instance, Butter-
worth filters will be saved using their S-plane Poles and Zeroes representation.
Atlas does not support saving a history of instrument response to SEED files. Only 
the applied instrument response will be saved.
Nanometrics data servers support only one read-only instrument response per 
channel.

6.3.2.4    Inverse Instrument Response and Instrument Simulation
To apply inverse instrument response or to simulate another instrument, apply an 
Inverse Instrument Response filter or an Instrument Simulation filter to a trace 
with available instrument response.
See also Section 6.2.3, “Inverse Instrument Response filter,” on page 82, Section 
6.2.4, “Instrument Simulation filter,” on page 82, and Section 6.1, “Creating and 
applying filters,” on page 71.

Table 6-13  Filter node options

Menu option Function

Properties Allows editing of the filter properties. See Section 6.2, “Filter options,” on 
page 76 for information about filter types and properties.

Delete Filter Deletes this filter from the response history.
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Chapter 7 Power Spectra

Atlas provides methods for calculating and plotting spectra for any trace or trace seg-
ment. Spectra can be plotted on multiple graphs or superimposed on a single graph. 
This chapter contains an overview of how power spectra are calculated and procedures 
for working with power spectra utilities.

7.1  Power spectrum calculation
Power spectrum is calculated using a multi-window technique. The trace is divided into 
smaller windows with 50% overlap. A data window is then applied to the segments to 
smooth results. The power spectrum is then calculated and summed over all segments. 
Smaller window sizes reduce noise at the cost of resolution.

7.1.1   Data windows

Four data window options have been implemented:4

None: Selects a box data window.

Hanning: 

Parzen: 

Welch: 

4. See page 442, Numerical Recipes in C, William H. Press and Co, Press Syndicate of the 
University of Cambridge, 1988.
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Chapter 7: Power Spectra
7.2  Power spectral density
Power spectral density is displayed on a log-log graph with spectral density on the ver-
tical axis and frequency, in hertz, on the horizontal axis. Spectral density is in units of 
g2/Hz, where g is the units of the trace.

7.3  Power spectra plotting options
This section contains procedures for plotting power spectra.

7.3.1   Plot a spectrum
1. Select a region of a trace for plotting the spectrum. If no region is selected, the 

entire trace will be used.

a) Click on the mark tool  in the trace tools toolbar.
b) Shift-click on the trace to place the starting marker, and then Shift-click on the 

trace to place the ending marker for the spectrum region.
The marked (red) region denotes the region for which power spectrum will be 
calculated.

To resize the marked region, either drag its end markers or Shift-click on the 
trace at the position for the new end marker.

2. Right click on the trace and choose Spectra from the pop-up menu, and then 
choose a spectra plot window to display the results (Figure 7-2).
• If there is no plot window currently open, you have the option to open the 

results in a new window.

Figure 7-1  Power spectra plot window
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• If a plot window is open, you have the option to open the new graph in a new 
window or to add the new power spectrum to an existing graph.

3. Select the data window plot settings from the Spectra Options dialog box, and then 
click Ok to plot the spectrum (Figure 7-3).
• Window Type – Selects the data window type: None, Hanning, Parzen, or 

Welch. (See also Section 7.1, “Power spectrum calculation,” on page 89.)
• Window Size – Selects the number of data points per window.

7.3.2   Change or reset the data range view

The data range displayed on the power spectrum graph can be adjusted, and can then 
be reset to the default view (Figure 7-4).

7.3.2.1    Offset axes
Click and drag the graph to offset the vertical and horizontal axes.

7.3.2.2    Zoom in
Right click and drag to select a region to zoom in on.

7.3.2.3    Reset view
In the View menu, click Reset View to reset offset axes and zoomed regions.

Figure 7-2  Open a power spectra plot window

Right click the trace with the marked region, choose Spectra, and 
choose a new or an existing plot window.

Figure 7-3  Spectra Options dialog box

Choose the data window type and size from the drop-down 
lists. (The Channel field displays the channel name and the 
number of points used to calculate the power spectrum.)
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Figure 7-4  Reset data range display
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Chapter 8 Maps

Atlas map utilities combine a geographical display of stations and epicentres with var-
ious attributes of the event. Fully interactive maps of an event provide options for you 
to view and refine solutions. (For example to see which stations contributed to the solu-
tion, make adjustments, calculate a new solution, and compare solutions.)

This chapter provides an overview of map features, and procedures for loading, view-
ing, editing, and customising maps of events.

8.1  Map window overview
This section provides an overview of the map window features. For detailed proce-
dures, refer to subsequent sections in this chapter.

Atlas map utilities allow you to:
Load and display maps that use various file formats
• ArcInfo
• ESRI shape files
• DTED
• Raster files: JPEG and GIF
Apply various projections
• Mercator
• Lambert Conformal Conic
• Stereographic
• Identity projection (no projection)
Customise map data settings—almost any aspect of an event may be shown visu-
ally, using a variety of widgets
Refine solutions with the interactive station and solution options
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8.1.1   Map window

The map window (Figure 8-1) displays all currently loaded maps and allows interaction 
with station and solution information. Data in the map window are displayed in four 
main panels, and in a status bar at the bottom of the window:

Map panel – Displays all currently loaded maps, stations, and various trace data 
indicators.
Depth slider panel – Displays depth information on the current solution.
Summary panel – Displays information about a station or epicentre when the 
mouse pointer is moved over the station or epicentre on the map.
Legend panel – Displays legend information on the visuals and data currently dis-
played on the map, as defined by the data settings. (See Section 8.5.2, “Customise 
the seismic event display,” on page 108.)
Location bar – Displays the longitude and latitude under the mouse pointer.

The Map panel displays event data. The three additional panels—Depth slider, Legend, 
and Summary—support interpretation of the map and provide utilities for refining a 
location calculation. Menus and toolbars provide additional options for data settings, 
and tools for working with solutions.

8.1.2   Map panel

The Map panel displays all currently loaded maps and allows interaction with stations 
and solutions. For example, you can move the centre of the view of a map, zoom the 
view in or out, and show detailed information about map components such as stations, 
traces, and the solution at the epicentre marker.

Figure 8-1  Map window overview

Settings list

Map panel

Station

Epicenter marker

Depth slider panel

Legend panel

Residuals bar chart

Summary panel
Location bar
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8.1.3   Depth slider panel

The Depth slider panel shows information about the depth of the solution. The depth 
slider shows the depth of the last solution (dark line), the depth of the reference solution 
(grey line), and the extent of the uncertainty (pink region). The Depth field shows the 
exact depth indicated on the slider. Zoom in, zoom out, and reset zoom buttons allow 
you to change the scale of the slider. The Fix Depth button allows you to set the depth 
to be fixed in subsequent Hypoinverse runs.

8.1.4   Summary panel

The Summary panel shows more detailed information about selected map components. 
For example, when the mouse pointer is placed over a station, information about that 
station appears in the Summary panel. The information displayed is subject to options 
you have defined in Data Settings, with the selected options shown in the Legend panel. 
For example, if there are no data settings for the station, just the station name is shown. 
If the data settings for the station include the time residual, station magnitude, and 
direction of first motion, the summary panel will show details of each of these 
attributes.

8.1.5   Legend panel

The Legend panel lists the map component symbols and what the symbols mean (for 
example, the initial Overview settings shown in Figure 8-2). Most symbols have a min-
imum value and a maximum value, indicated by shape or colour. For an attribute that 
is discrete, such as Trace Data Available, the symbol displayed on the map will be 
either be “on” or “off”. For an attribute that has some range, such as residuals, the sym-
bol displayed on the map will show an incremental value within the range.

Figure 8-2  Map legend panel showing initial Overview data settings
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8.2  Loading and removing maps
Atlas is shipped with a starter set of map files. The first time you open a map window 
in Atlas, the default world map is displayed. Subsequent opening of a map window will 
load the maps used during the last map window session for any event. You can load 
maps of various file formats, and remove maps. Once a map is loaded, you can modify 
various data and display settings (see Section 8.5, “Customising map and event dis-
plays,” on page 106).

Note Maps can use a large amount of memory, depending on their complexity; 
also, each map window loads a separate instance of each map. If the 
computer is running out of memory, remove some maps or close some 
map windows.

8.2.1   Supported map file formats

Atlas supports the following file formats for maps:
ArcInfo (file extension .E00)
ESRI shape files (file extension .SHP)
DTED: Digital Terrain Elevation Data (file extensions .DT0, .DT1, ..., .DT5)
Raster files: JPEG and GIF (files extensions .JPG, .GIF)

8.2.2   Load a new map

Note When more than one map is displayed, the first map loaded will be drawn 
first and any additional maps loaded will be drawn over top. You can 
change the order of maps by dragging them in the Map File Settings win-
dow (see Section 8.5.1.2 on page 107).

You can load a new map from the file menu, and from the file settings window. If the 
map being loaded is a raster file (a .JPG or .GIF extension), it may need to be located 
geographically; see Section 8.2.3.

8.2.2.1    Load a map using the File menu
1. In the map window File menu, choose Load Map File (Figure 8-3).

2. In the Select Map File dialog box, enter the path and name of the file.

8.2.2.2    Load a map using the File Settings dialog box
1. In the map File menu, choose Map File Settings.

Figure 8-3  Load a map file
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2. In the Map File Settings dialog box (Figure 8-4), right click on the Map Files node, 
and then choose Load new map from the pop-up menu.

3. In the Select Map File dialog box, enter the path and name of the file.

8.2.3   Locate a raster map

Raster map files (with a .JPG or .GIF extension) are usually created with scanned 
maps of an area. Once loaded, the map may need to be located geographically.

Atlas uses two assumptions when locating a raster map:
The map is not projected—that is, the separation between lines of longitude and 
the separation between lines of latitude remain constant throughout the map 
(though the two constants do not need to be identical).
Lines of latitude run horizontally and lines of longitude run vertically. (If this is 
not the case, you can rotate the map using an image editing program before load-
ing the map.)

Once the raster map has been located, a file with the same name as the map file but with 
the extension .loc will be created in the same directory as the map file. The .loc file 
contains location information for the map. Atlas searches for a .loc file when loading 
raster images.

1. Load a new raster map (see Section 8.2.2), or select Locate from the Map File Set-
tings window (Figure 8-5).

2. In the Set Geophysical Location dialog box (Figure 8-6), double click on the map 
to set the location of Point 1, and double-right click on the map to set the location 
of Point 2. (To view different areas of the map, you can click and drag the map to 
move the centre of view, and right click and drag to zoom in or out.)

Figure 8-4  Load a new map

Figure 8-5  Locate a raster map
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When selecting the two points, try to keep them as far apart as possible, both verti-
cally and horizontally, as this reduces the error. The points cannot be on the same 
vertical or horizontal line.

3. In the fields at the bottom of the dialog box, enter the longitudes and latitudes for 
both Point 1 and Point 2.

4. Click OK to create the .loc file for the map file. (To discard the changes, click 
Cancel.)

8.2.4   Remove a map
1. In the map File menu, choose Map File Settings (Figure 8-7).

2. In the Map File Settings dialog box, right click on the name of the map to remove.

3. In the pop-up menu, choose Remove Map.

8.3  Viewing mapped data
The map displays all currently loaded maps (see Section 8.2) and provides options to 
view data about map components (such as stations and solutions).

Figure 8-6  Set geophysical location for a raster map

Figure 8-7  Remove a map
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8.3.1   Open an event map

Note Maps can use a large amount of memory, depending on their complexity; 
also, each map window loads a separate instance of each map. If the 
computer is running out of memory, remove some maps from the Map 
Settings Window or close some map windows.

Numerous event map windows can be displayed simultaneously.

Open and select the event, and then click the Show map button .

A new map window will open, with the view centred around the stations and epicentre 
for the event. If the map window is not centred around the event, it may be that no 
appropriate maps have been loaded or that the current projection settings exclude the 
geographical area for the event. (See also Section 8.2.2, “Load a new map,” on page 96 
and Section 8.3.6, “Change the map projection,” on page 101.)

8.3.2   View different areas of a map

You can move a map within a window, and zoom the view.

To move the centre of view, click and drag the map.

To zoom the view of an area, use either of these methods:

Right click and drag (drag up to zoom in and drag down to zoom out).

Click the appropriate zoom button in the upper right corner of the map window: 
zoom out , zoom in , or reset to the initial view .

8.3.3   View station information

You can view summary information, and detailed information for a station.

To view summary information about the station, move the mouse pointer over the 
station symbol. Station information will be displayed in the Summary panel. Only 
data defined by the current data settings are displayed.

To view all available information about the station, use either of these methods:

Double click the station symbol.

Right click the station symbol and choose Show Station Data from the pop-up 
menu.

Station information will be displayed in a pop-up window.

8.3.4   Highlight trace data in the Atlas main window
To select data traces for a station in the Atlas event window, click the station sym-
bol.

This will open the solution in the Atlas Solutions panel and select the first trace for the 
station as the zoom trace in the Atlas event window.
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8.3.5   View solution information

You can view information about a solution, display sub-sets of data for a solution, and 
view a different solution for the same event.

8.3.5.1    View information about the current solution
To view summary information about the epicentre, move the mouse pointer over 
the epicentre marker. Epicentre information will be displayed in the Summary 
panel.

To view all available information about the solution, use either of these methods:

Double click the epicentre marker.

Right click the epicentre marker and then choose View Complete Solution in 
the pop-up menu.

A solution details dialog box (Figure 8-8) will display solution information, with 
options to view additional details such as arrivals.

To open the solution in the Atlas window, click the epicentre marker.

8.3.5.2    View a subset of solution data
In the data settings toolbar, you can choose different data setting subsets from the 
drop-down list (Figure 8-9). (See Section 8.5.2, “Customise the seismic event dis-
play,” on page 108 for information on customising data settings.)

Figure 8-8  Solution details

Figure 8-9  Choose solution data settings
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8.3.5.3    View another solution for the event

If more than one solution has been located for the event, you can open another of the 
solutions in the map window using the Solution drop-down list (Figure 8-10).

8.3.6   Change the map projection

You can select different map projections, and apply these to maps that are in either vec-
tor or raster format.

8.3.6.1    Supported map projections

Atlas supports several standard map projections:
Identity projection (no projection)
Mercator
Lambert Conformal Conic
Stereographic

8.3.6.2    Change the current map projection
1. In the Map window menu bar, choose View > Map Projection. The currently 

active projection and associated settings will be shown in the Map Projection dia-
log box (Figure 8-11).

2. Choose a projection from the drop-down list.
Each projection setting includes the ranges of longitude and latitude to display. All 
coordinates are entered in degrees. The map will be clipped to display only the 
area within these limits. In addition, for Lambert and Stereographic projections 
you can select the latitude and longitude displayed at the centre of the projection.

3. To project raster maps using the new projection, click Project Image Maps to tog-
gle the option on .

Note Projection of image maps may take a long time, as each pixel of the map 
needs to be projected.

Figure 8-10  View another solution for the event
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8.3.7   Print a map
1. In the Map window menu bar, choose File > Print Map (Figure 8-12).

2. In the Print Map Options dialog box, select options to print one or all of these pan-
els: map, legend, and depth slider.

3. Click Ok to open the print dialog box and then print the map.

8.3.8   Close a map window
To close the map window, either click the close icon  in the upper right corner of 
the Map window, or choose File > Exit.

8.4  Editing mapped solutions
The map window provides options to edit mapped solutions. For example, you can edit 
picks for a station or channel, move the epicentre marker, set trial depths, and fix 
depths. These options are available through map objects, pop-up menus, and the solu-
tion toolbar:

Directly manipulate map objects, such as the depth slider or epicentre marker.
Use options in a pop-up menu associated with a map object, such as the epicentre 
marker (solution menu), or a station symbol (station menu).
Use options in the map solution toolbar.

Figure 8-11  Open the Map Projection dialog box

Figure 8-12  Print a map
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Note The options on the map solutions toolbar (Figure 8-13) and in the map 
solutions pop-up menu (Figure 8-14) are the same as those provided in 
the Atlas main window. These options are reviewed briefly in the sections 
below, with references to additional information in the sections describing 
Atlas main window options.

8.4.1   Open the map solution menu
Right click on the solution to display the solution pop-up menu (Figure 8-14).

8.4.2   Move the solution to a trial location

Note You can drag the solution only if the current Hypoinverse settings for trial 
hypocenter are configured to “Set initial conditions” (see Section 5.4.4 on 
page 64).

You can move the solution to a trial location by dragging the current solution symbol 
(for example, ). The new location will be used as a starting point for calculating the 
next solution.

Click and drag the solution to a new location.

8.4.3   Move the epicentre marker

You can move the epicentre marker  to a new location.

Right click on the map at the new location and then click Set Marker in the pop-up. 
(To cancel, click anywhere outside the Set Marker pop-up.)

Figure 8-13  Map solution toolbar

Figure 8-14  Open the map solution menu

Right click the solution marker to open 
the solution pop-up menu.
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8.4.4   Set a trial depth
In the depth slider window (see Figure 8-1 on page 94), click and drag the depth 
slider  to the new depth.

To access a depth that is not shown on the slider, click zoom out  until the 
depth wanted is visible. (You can also zoom in  to decrease the range shown, 
and reset the slider to the starting configuration .) 

If the slider is not editable, then the initial conditions are set to defaults in the 
Hypoinverse Settings.

To make the slider editable, edit the Hypoinverse settings (see Section 5.4.4.5, 
“Set initial conditions for Hypoinverse calculations,” on page 67).

Note Hypoinverse allows the setting of a trial depth that applies to all location 
runs. The default depth is 7km, but may be reset by editing the Hypo Set-
tings (see Section 5.4.4.5 on page 67). Before locating, the depth can be 
reset for the current run.

8.4.5   Fix the current depth
In the Depth slider panel, select the Fix Depth button to fix the depth of the current 
run , and for subsequent Hypoinverse runs.
• If this button is not selectable, the Hypoinverse Settings are set to use default 

initial conditions.
• If this button is selected and not editable, then the settings are set to a fixed 

depth and all Hypoinverse runs will fix depth (see Section 5.4.4.5, “Set initial 
conditions for Hypoinverse calculations,” on page 67).

8.4.6   Create a new solution

See also Section 5.3.1, “Create a new solution,” on page 56.

Toolbar button: 

8.4.7   Copy the currently active solution

See also Section 5.3.9, “Copy a solution,” on page 58.

Menu option: Copy Solution

Toolbar button: 

8.4.8   Locate the solution

See also Section 5.3.2, “Locate a solution,” on page 56.

Menu option: Locate Solution

Toolbar button: 
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8.4.9   Set the current solution as the preferred solution

See also Section 5.3.6, “Set a preferred solution,” on page 57.

Menu option: Set as Preferred Solution

8.4.10   Set the current solution as the reference solution

See also Section 5.3.7, “Set a reference solution,” on page 57.

Menu option: Set As Reference Solution

Toolbar button: 

8.4.11   Copy the reference solution

See also Section 5.3.8, “Copy the reference solution,” on page 58.

Toolbar button: 

8.4.12   Edit the solution comment

See also Section 5.3.12, “Create or edit a solution comment,” on page 59.

Toolbar button: 

8.4.13   Delete the currently active solution

See also Section 5.3.13, “Delete a solution,” on page 59.

Toolbar button: 

8.4.14   Edit picks

You can edit each type of pick (P, S, Duration, and Amplitude) that exists for a station, 
using options in the solution menu. There is also a sub-menu for each of the channels 
that allows you to activate or deactivate the pick, and to delete the pick, using the sta-
tion pop-up menu.

8.4.14.1    Edit phase picks

See also Section 5.4.3.2.1, “Edit picks,” on page 63.

Menu option: Edit Picks

8.4.14.2    Edit amplitude picks

See also Section 5.4.3.2.2, “Edit amplitudes,” on page 64.

Menu option: Edit Amplitudes
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8.4.14.3    Enable/disable or delete picks for a channel
To enable, disable, or delete picks for a channel, use either of these methods:

Use the menu options to access pick edit windows (see also Section 5.4.3.2, 
“Modify picks using Edit Picks and Edit Amplitudes tables,” on page 63).

Right click on the station symbol, and from the station pop-up menu choose the 
option to enable/disable or to delete picks (Figure 8-15). 

8.5  Customising map and event displays
There are two types of display settings for Atlas maps:

Map file settings (File > Map File Settings) – Use these settings to customise dis-
play characteristics of maps, such as fill colour and transparency.
Seismic event display settings (View > Data Settings) – Use these settings to 
define subsets of event data to include on a map, and how to display each piece of 
information in the subset.

8.5.1   Customise the map file display

Use options in the Map File Settings dialog box to customise display characteristics of 
maps.

8.5.1.1    Open the map file display settings
1. Choose File > Map File Settings to open the Map File Settings dialog box (Figure 

8-16).

2. Click the Map Files node to open the list of maps, and then click a map file node to 
view the display settings for the map (Figure 8-17).

Figure 8-15  Edit picks from the map

Right click the station symbol to open the 
station pop-up menu.

Figure 8-16  Open the Map File Settings dialog box
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The Map Files tree in the left panel lists all maps currently loaded in this map window. 
The map display settings are shown in the right panel for the map file selected in the 
tree.

8.5.1.2    Change the order of maps displayed

The order of maps listed in the Map Files tree determines the order in which maps will 
be drawn in the map window: Maps that are listed lower on the tree will be drawn 
superimposed on maps listed higher on the tree. (For example, in Figure 8-17 
cal1.jpg will be drawn on top of world.shp.)

1. Click and drag the map file node to a new position on the file tree to change the 
map display order. 

2. Click Update to redraw the maps using the new ordering, and click Ok to close the 
map settings dialog box.

8.5.1.3    Change the display settings for a map

The options for changing map display settings depend on the map file format.

Change map file display settings using options listed in Table 8-1, and then either:

Click Update to redraw the map using the new settings, without closing the 
map file settings dialog box.

Click Ok to close the map file settings dialog box and redraw the map using the 
new settings.

Note Changes to image files will force them to be recalculated and redrawn. If 
the image files are being projected, this may take a long time. (See also 
Section 8.3.6, “Change the map projection,” on page 101.)

Figure 8-17  Edit display settings for a map file

Table 8-1  Map file display options

Option Description

Visible Click this option to select whether the map is drawn  or not drawn 
 in the map window.
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8.5.2   Customise the seismic event display

Different stages in the process of locating an event require different pieces of informa-
tion. Atlas provides tools for you to create and edit data settings groups to display sub-
sets of data relevant to the different stages.

8.5.2.1    About data settings groups

A data settings group defines what subset of data to include on a map and how to dis-
play each piece of information, such as a P-pick residual. Many pieces of information 
can be displayed by a single data settings group. For example:

A settings group used before an event is located for the first time may display 
which stations have traces and whether picks are available.
A settings group for refining a solution may display pick and magnitude residuals 
and compare them to the reference solution.

You can create multiple data settings groups, and apply any group to a map using the 
Settings drop-down list in the map window (Figure 8-9 on page 100). The legend panel 
of the map window displays the currently selected data settings (Figure 8-1 on 
page 94).

The procedures for creating and editing data settings groups are similar. The Settings 
drop-down list in the Seismic Event Display Settings dialog box (Figure 8-18 on 
page 109) lists all existing data settings groups, and allows selection of a group for edit-
ing. The settings under each of the three tabbed panels constitutes the data settings 
group currently selected in the Settings drop-down list.

Transparency % Use the Transparency level to set the transparency of a map, from 
opaque to fully translucent. (Translucent maps will show what is 
underneath them.) Translucent maps will be drawn more slowly than 
opaque maps.

Type in a value within the range 0 (fully opaque) to 100% (fully 
translucent) in the Transparency field to vary the transparency.

Whiteout % Use the Whiteout level to reduce contrast within the map, making it 
easier to see objects on top of the map. Whiteout blends the map 
colours with the selected percentage of white.

Type a value within the range 0 (original colours) to 100% (com-
pletely white) in the Whiteout field to vary the contrast.

Fill Color • Only available for vector maps.
Fill Color is the colour that is used to paint the inside of the map for 
ESRI shape files, or the lines for ArcInfo files.

Click on the colour field to open the colour chooser dialog box, 
and select a new fill colour.

Line Color • Only available for ESRI shape files.
Line Color determines the outline colour for shapes.

Click on the colour field to open the colour chooser dialog box, 
and select a new line colour.

Table 8-1  Map file display options (Continued)

Option Description
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Use options on the three tabbed panels, and the five function buttons at the bottom of 
the dialog box, to edit the station, epicentre, and reference epicentre display settings for 
existing settings groups, and to create new settings groups. See the following sections 
for procedures and options.

The tabbed panels include:
Station – Displays settings for each station displayed on the map.
Epicenter – Displays settings for the epicentre for the current active solution.
Reference epicenter – Displays settings for the epicentre for the current reference 
solution.

The function buttons include:
Ok – Accepts the changes and exits the dialog box.
Cancel – Ignores all changes and returns to the map window.
Add – Adds a new data settings group to the settings drop-down list. The group 
will be called New Settings, and it will contain no data settings.
Copy – Creates a new data settings group that is identical to the current active 
group.
Delete – Deletes the current active settings group, without prompting for confir-
mation.

8.5.2.2    Open the seismic event data settings
Choose View > Data Settings to open the Seismic Event Display Settings dialog 
box (Figure 8-18).

Figure 8-18  Open the Seismic Event Display Settings dialog box
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8.5.2.3    Change a data settings group name
1. In the Settings drop-down list, choose the data settings group for which you want 

to change the name.

2. Type in a new name, and then click Ok to apply the changes to the data settings 
group.

3. Click Ok to close the dialog box with saved changes to the name. (To discard the 
changes, click Cancel. Cancel will also discard any changes made to other settings 
groups during this dialog box session.)

8.5.2.4    Select data display options

Seismic event data display settings can be customised for station, epicentre, and refer-
ence epicentre data.

Each data setting includes three components (Figure 8-19):
Data type – The piece of information to display on the map (options are listed in a 
Choose data to display dialog box; for example, Figure 8-20).
Symbol type – A symbol to represent the selected data type.
Symbol attributes – Attributes for the data symbol (if applicable).

The options for each of the components depend on whether the settings are for station 
or epicentre data.

Figure 8-19  Data settings components

Symbol type

Data type

Symbol attributes
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8.5.2.4.1    Station display settings

Station data display settings include general options (Table 8-2), options to select spe-
cific data types to display (Table 8-3), and settings for the selected data types (Table 8-
4).

Station data types can be Empty (no data type is selected), or not empty (data is either 
an Active or a Reference solution data type). Data types and options are the same for 
both Active and Reference solutions.

Figure 8-20  Open the Choose data to display dialog box

Table 8-2  Station general display options 

Option Description

Station Click this option to select whether station symbols are displayed  or not 
displayed  on the map.

Show Names Click this option to select whether station names are displayed  or not 
displayed  on the map.

Size Use the size slider to change the size of the station symbols displayed on 
the map.

Table 8-3  Station data types 

Data type Description of options

Empty Select this option to display no information or to clear the 
entry of another data type.
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Once a symbol has been selected to represent a piece of information, in most cases there 
is an option to set an additional attribute relevant to the symbol type (for example, 
shape, colour, or line thickness).

Options available to display a piece of information are different depending on the piece 
of information. For instance, the first motion for a given station may be displayed by 
changing the shape of the station. This is not available for a pick residual. Also, certain 
ways of showing information can be used only once within a data settings group. For 
example, a bar chart can be selected to display any number of pieces of information. 
Colour can only be set for one piece of information; once it is used, it will no longer 
appear as an option.

Trace Data Shows whether trace data are available in the current event 
for the station.
• Available – Shows whether the event contains traces for 

the station. Options are true (100%), false (0%)
• First Motion – Shows the first motion detected at the sta-

tion. Options are Up, Down, or Unknown.

P Phase
S Phase

• Pick Available – Shows if the phase has been defined for 
the station.

• Pick Weight Code – Weight code for the phase as passed 
to hypolocate. Two weight codes are currently available: on 
(100%) and off (0%).

• Arrival Weight Used – Shows the actual weight of the 
arrival as used by hypolocate for the pick.

• Pick Residual – Shows the residual between the actual and 
calculated picks.

Duration Magnitude
Local Peak-Peak Magnitude

• Pick Available – Shows if a duration magnitude pick has 
been set for the station.

• Pick Weight Code – Displays the weight code passed to 
hypolocate for the duration magnitude.

• Station Magnitude – Shows the station duration magnitude 
calculated.

• Residual – Shows the residual between the calculated and 
actual duration magnitudes for the station.

Table 8-4  Station symbol options 

Option Description

Bar Chart Displays a piece of data as one of the entries on a bar chart above the station 
symbol.
• Any number of pieces of information can be displayed with this symbol 

option.
• Editable attributes – Colour.

Circle Displays a piece of data as a circle around the station symbol. The size of the 
circle will be determined by the value of the data.
• Any number of pieces of information can be displayed with this symbol 

option, each piece of information creating its own circle.
• Editable attributes – Colour.

Table 8-3  Station data types  (Continued)

Data type Description of options
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8.5.2.4.2    Epicenter and Reference Epicenter display settings

Epicentre data display settings are used for the active solution, reference epicentre set-
tings are used for the reference solution. The options are the same in both the Epicenter 
and Reference Epicenter tabbed panels.

Epicentres are displayed on a map using two circles:
The origin of the event for the current active solution is represented by a dark cir-
cle that remains the same size at any map zoom.
The solution error is represented by a circle (usually red) around the epicentre that 
covers the same geographical area at any map zoom.

The reference solution is displayed using a different set of circles on the map.

Color The fill colour for the station symbol will vary between two colours 
representing a minimum and a maximum value, depending on the value of 
the data being displayed. 
• One piece of information per data settings group can be displayed with this 

symbol option.
• Editable attributes – Colour.

Outline The outline colour for the station symbol will vary between two colours, 
representing a minimum and a maximum value, depending on the value of 
the piece of information being displayed.
• One piece of information per data settings group can be displayed with this 

symbol option.
• Editable attributes – Line thickness, colours for minimum and maximum 

values.

Shape The shape of the station symbol can be associated with a specific value for 
the piece of information being displayed, for example an up triangle to 
represent first motion, a square to represent unknown. 

Click Ok after setting each shape in the set for a data type.
• Pieces of information that have specific states (such as true or false, up or 

down) can be displayed with this symbol option.
• One piece of information per data settings group can be displayed with this 

symbol option.

• Editable attributes – Select a shape from any of up triangle , down trian-

gle , square , square with a top hat , or square with a bottom hat 

.

Symbol Size The size of the station symbol varies as a function of the value of the piece of 
information being displayed.
• One piece of information per data settings group can be displayed with this 

symbol option.
• No editable attributes.

Line A line is drawn from the current epicentre to each station. The length of each 
line is determined by the piece of information being displayed.
• One piece of information per data settings group can be displayed with this 

symbol option.
• Editable attributes – Colour.

Table 8-4  Station symbol options  (Continued)

Option Description
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Epicenter and Reference Epicenter data display settings include general options (Table 
8-5), options to select specific data types to display (Table 8-6), and settings for the 
selected data types (Table 8-7).

Table 8-5  General epicentre display options 

Option Description

Epicenter Click this option to select whether the origin circle is displayed  or 
not displayed  on the map.

Epicenter Error Click this option to select whether the error circle is displayed  or not 
displayed  on the map.

Figure 8-21  Epicenter data settings

Table 8-6  Epicenter and Reference Epicenter data types 

Data type Description of options

Empty Select this option to display no information or to clear the entry of another data 
type.

Depth Displays the depth of the epicentre.

Magnitude • Duration – Displays the duration magnitude for the solution.
• Local Peak-Peak – Displays the local peak-to-peak magnitude for the solu-

tion.
• Preferred – Displays the preferred magnitude for the solution.

Table 8-7  Epicenter and Reference Epicenter symbol options 

Option Description

Center Color The fill colour for the origin circle will vary between two colours, representing 
a minimum and a maximum value, depending on the value of the data being 
displayed. 
• One piece of information per data settings group can be displayed with this 

symbol option.
• Editable attributes – Colour.
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8.5.2.5    Create a new data settings group
1. Open the Seismic Event Display Settings dialog box, and then click Add. An 

empty data settings group will be created, with the name New Settings.

2. Type in a name for the settings group, and then edit the data settings using the 
options described in Section 8.5.2.4.
a) Click a data type button to open the Choose data to display dialog box.
b) Select the data type from the Data type tree, and then click Ok.
c) Choose a symbol type from the drop-down list (for example, Bar Chart), and 

then set the symbol attributes (for example, Color) if the symbol type has edita-
ble attributes.

3. Click Ok to apply the values to the new settings group.

4. Click Ok to close the dialog box with saved values for the new data settings group. 
The new settings will immediately be applied to the event map. (To discard the 
changes, click Cancel. Cancel will also discard any changes made to other settings 
groups during this dialog box session.)

8.5.2.6    Edit an existing data settings group

For an existing data settings group, you can add and remove individual data items from 
the map display, and change settings for displayed items.

1. In the Settings drop-down list, choose the data settings group for which you want 
to edit display settings.

2. Edit the data settings using options described in Section 8.5.2.4:
a) Click the data type button to open the Choose data to display dialog box.
b) Select the data type from the Data type tree (to remove a data type from the cur-

rent settings, select Empty), and then click Ok.
c) Choose a symbol type from the drop-down list (for example, Bar Chart), and 

then set the symbol attributes (for example, Color) if the symbol type has edita-
ble attributes.

Error Color The fill colour for the error circle will vary between two colours, representing 
a minimum and a maximum value, depending on the value of the data being 
displayed. 
• One piece of information per data settings group can be displayed with this 

symbol option.
• Editable attributes – Colour.

Center Size The size of the origin circle varies as a function of the value of the piece of 
information being displayed.
• One piece of information per data settings group can be displayed with this 

symbol option.
• No editable attributes.

Table 8-7  Epicenter and Reference Epicenter symbol options  (Continued)

Option Description
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3. Click Ok to close the dialog box with saved changes to the settings. (To discard the 
changes, click Cancel. This will also discard any changes made to other settings 
groups during this dialog box session.)
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Appendix A Hypoinverse

A.1  Introduction
Atlas uses Hypoinverse, a location program written and used by the United States Geo-
logical Survey (USGS), to locate earthquakes and calculate magnitudes. Documenta-
tion for Hypoinverse is at the ftp site ftp://clover.wr.usgs.gov/pub/ehz/klein/hyp2000/. 
The document docs/hyp2000-1.0.* gives instructions on how to set up, run, and 
interpret Hypoinverse.

Atlas creates an input file listing phases and any magnitude information in memory, 
then calls the executable, which writes an output file. The output file is parsed and put 
in memory. When Atlas or the event window exits, the new information is lost unless 
it is deliberately saved to the database.

Hypoinverse operates with a set of files that give instructions for which stations to use 
in calculations as well as any weights, delays, or corrections to apply. The paper trail 
is quite complicated, so a result may be a function of several parameters from multiple 
files. Atlas ships with an initial set of files but some of these files will probably not 
apply to your network. In addition, the Hypoinverse output is not completely parsed, 
so not all of the output will get saved. The following three sections will discuss how to 
setup the Hypoinverse suite of files, how Atlas constructs and parses the input and out-
put files, and finally, some of the limitations of Hypoinverse.

A.2  How to set up Hypoinverse
Hypoinverse is a FORTRAN program that calls a file named hypinst, which con-
tains Hypoinverse commands as well as links to additional command files. As part of 
the initial setup shipped with Atlas, hypinst calls the command file Atlas.hyp, 
located in the user\hypoinverse directory. Then, hypinst names the input and 
output files and locates the event. If any of this information is changed, Hypoinverse 
will still run, but the connection to Atlas may break.

The input file called HypoAtlasIn is created by Atlas and placed in the user direc-
tory. This file contains phase, duration, and amplitude data from Atlas memory that 
Hypoinverse uses for calculations. The output file, HypoAtlasOut in the same direc-
tory, is an arc file produced by Hypoinverse and parsed by Atlas. The format of both 
files is the same and is described in detail in the docs/hyp2000-1.0.* mentioned 
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Appendix A: Hypoinverse
in Section A.1. The contents of the files represent the last run of Hypoinverse. Details 
of how Atlas parses the output are discussed in Section A.3.

The initial Hypoinverse setup is a simplified version of the setup shipped with Earth-
worm 6.0. The files are located in user/hypoinverse. The file hypinst invokes 
the command file Atlas.hyp that gives Hypoinverse the station list, the station cor-
rections and delays, the crustal model or models, and what magnitudes to calculate. As 
a user, you probably should become familiar with this file as it gives you complete con-
trol over what Hypoinverse calculates.

The commands H71, STA, WET, ZTR, DIS, and RMS, as well as the name of the crustal 
model command file, may be edited using the Hypoinverse Settings Editor. Access the 
editor with the Tools > Customize – location – Edit Hypoinverse Settings button, or 
with the Edit HypoSettings button on the pre-locate dialog. (See Section 5.4.4 on page 
64 for details.) Anything outside the Atlas Content bars may be edited. If you edit 
within the bars, unforeseen effects may occur.

Atlas.hyp has a few items important to Atlas, but for the most part may by edited 
at will. The following commands should be edited with care:

H71 tells Hypoinverse the format of the input and output files. The arguments 
should be either of 1 1 3 or 1 3 3 only. The middle argument tells Hypoinverse 
to use the initial origin in the header line (3) or not (1).
STA tells Hypoinverse what stations to consider. Atlas constructs the station file 
AtlasStations.hinv with default parameters from the station information in 
memory. If the location of the stations is not in memory, the station will not be 
written to AtlasStations.hinv and Hypoinverse will not be able to use any 
information from that station. You may construct your own station file and have 
the STA command point to it instead. (Be sure to use the full path to the file, or the 
relative path from the user directory). As an alternative, you may edit the file 
UserStations.hinv as a “permanent” station file. If this file is not found, 
Atlas will create it the first time Hypoinverse is run and, subsequently, will be 
used in the creation of AtlasStations.hinv which is recreated each time 
Hypoinverse is run. This route has the advantage of making data from outside your 
network useable, but still be able to fully define station information from your net-
work.
@hypoinverse/AtlasCrustalModel.hyp directs Hypoinverse to the 
command file listed. This command file defines a default crustal model based on a 
simplified model from the Northern California Seismic Network. 

Note You will need to develop and place your own crustal model if the Hypoin-
verse results are to reflect the geophysical conditions of your network. 
See docs\hyp2000-1.0.* for more information.

Most of the other commands in Atlas.hyp reflect the default settings for those com-
mands.

Atlas will only consider the primary duration and primary amplitude magnitudes in this 
release. The MAG command in Atlas.hyp is formulated to calculate traditional dura-
tion magnitude, to use the weights on the phase cards, and to use Eaton’s distance cor-
rection. These settings may be changed, but Atlas only considers the primary duration 
magnitude. If the remark character for the magnitude in the summary line of HypoAt-
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lasOut, column 118, is the same as the remark in the code for duration on the phase 
line, column 110, then the station magnitude is read and saved as part of the duration 
magnitude. This code is set with the command FC1 in the Atlas.hyp file. If these 
conditions are not met the duration pick will not be saved to the database.

The settings for the amplitude magnitude will also use the Eaton’s distance correction 
as a default. This may be changed in the Atlas.hyp file using the LA0 command to 
specify which channels use a different formulation. If the remark code in column 122 
of the summary line in HypoAtlasOut matches the code in column 111 of the phase 
line, then the station magnitude will be parsed and saved by Atlas. This code is set with 
the command XC1 in the Atlas.hyp file.

A.3  How Atlas uses Hypoinverse
There are several avenues to locate an event. To locate interactively, press the locate 
button on the toolbar or right click on a solution and choose locate. The contents of the 
input file will be shown for editing, and the output of Hypoinverse will pop up in a sep-
arate window if these options are chosen. To turn either of these options on or off, 
choose Tools > Customize – location, or use the checkbox options on the panels. 
Hypoinverse is also called for all unlocated solutions in an event before saving to a 
database; if hypoinverse fails, the solution is not saved. If no solutions are saved, the 
event will be saved as an unlocated event. (See also Chapter 5.)

The main reason that hypoinverse would fail is not enough valid picks. To be valid, a 
pick time must be within 6 minutes of all other pick times. The location of the stations 
must be fairly close together. The DAM command sets the minimum distance of the sec-
ond closest station. The default is 250km. This command is in the Atlas.hyp file. 
The pick will also not be used by Hypoinverse if the station is not in the station file 
defined by the STA command.

In addition to these restrictions, if the H71 command is set to 1 3 3, then the time and 
location in the first line of the input file is used as the initial origin by Hypoinverse. The 
arrival times must be within 6 minutes of the summary time and at least some station 
locations must be within 250km of the trial origin (if the DAM command is left to 
default). This precludes teleseismic events from being analyzed by Hypoinverse.

Lastly, Hypoinverse may fail if the format is not followed precisely. If the input file is 
edited incorrectly, Hypoinverse may fail. Any failure will be reported in the output 
screen. A failed attempt will not affect the solution in memory.

To locate an event, Atlas constructs an input file called HypoAtlasIn that gives 
Hypoinverse an initial time and (possibly) initial location, as well as station phase and 
magnitude information. The contents of this input file may be edited just before locat-
ing. Hypoinverse calculates the location and magnitude, then writes to a file called 
HypoAtlasOut. Both input and output files are overwritten each time Hypoinverse 
is called.

HypoAtlasIn starts with a summary line which holds an initial time and, if availa-
ble, a location. The time is the current time of the event of the solution, or if not defined, 
the time of the earliest pick. The location is left blank unless the previous solution con-
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tains that information. In addition, the summary line contains the number of phases as 
well as the ID of the event if the event is in the database.

The phase lines contain both the pick and magnitude information and are separated 
from the summary line as well as each other by a line starting with $. The format of 
both the input and output files are detailed in the Hypoinverse documentation, p.93.

The picks for a solution are based on P (green) and S (yellow) picks you see on the 
traces. In addition, there may be paper picks for channels that have no traces. These 
paper picks may be picks from the database or they may have been added in the Atlas 
session.

Pick weights used by Hypoinverse are complicated. A weight code is set in the input 
file on the phase line by Atlas. It will be 0 for 100% weight and 6 for zero weight. 
Hypoinverse uses this code, along with station weights set in the station file and 
weights applied as a function of the time residual and distance from the earthquake, to 
calculate a final weight used (see RMS and DIS commands in the documentation). This 
final weight is reported in HypoAtlasOut and saved to the database. For this reason, 
when an arrival is retrieved from the database, the weight will be either 1, if the final 
weight is > 0, or 0 if the final weight is 0.

Both phase picks and their weights as well as duration picks can be edited in the Solu-
tion tab of the main Atlas window. Click on the Solution tab, then right click a solution 
and choose Edit Picks. Any text may be used for the pick type, but if it does not have a 
P, S, or D in the type field, the pick will be ignored.

Magnitude picks are duration or amplitude picks. Duration picks are set with a Shift- 
click if the D on the toolbar is selected. The pick will only be used if a corresponding 
P-pick is set for the trace.

Amplitude picks are set on the trace with a Shift-click if the A on the toolbar is selected. 
A red-brown pick will appear on the nearest peak. To set a period, drag the pick to 
another peak. The actual amplitudes of both peaks will determine the amplitude of the 
pick. If only one pick is set, the second amplitude will be calculated by this relation:

amplitude2 = amplitude1 – 2*(amplitude1 – meanAmplitude)

which doubles the zero to peak amplitude.

The amplitude used in Hypoinverse will be the absolute value of the difference between 
amplitude1 and amplitude2. The period will be blank if only one pick is used, and 
2*(the time difference) if two picks are used.

The unit flag is set to 0 for peak to peak in mm. The mm unit is ignored if the instrument 
type is greater than zero. The instrument type may be set in the UserStation.hinv 
file, but it may be reset in the amplitude magnitude correction called with the XMC com-
mand; see p.23 of Hypoinverse Documentation. The instrument types available are 
listed on p. 50, table 2 of the same document.

If the instrument type is set to zero, Hypoinverse assumes the amplitude is the peak to 
peak amplitude in mm of a Wood-Anderson instrument. If instrument response is avail-
able, Atlas allows the conversion of a digital trace to Wood-Anderson.

The weight codes for both magnitudes are set to 0 or 6 (which is interpreted as 100% 
or 0% respectively). Weights can also be set in the UserStation.hinv file as well 
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as the magnitude correction files (see XMC for amplitude magnitude and FMC for dura-
tion magnitude in the documentation).

Magnitude data is entered on the phase lines of the input file. Format is shown on p.95 
of the documentation. Atlas currently does nothing with the secondary duration or 
amplitude magnitudes or the external magnitude. Atlas can save the individual station 
magnitudes if the codes in the summary line col 118 and col 122 are the same as the 
codes on the phase lines cols 110 and 111 respectively. These codes are set with the 
FC1 and XC1 commands. 

A.4  Hypoinverse limitations
Hypoinverse is limited to events fairly close to the stations involved. It has problems 
locating if the stations are too far away from events, leaving teleseismic events out of 
the location capabilities of Atlas. In particular, if the time of any pick is more than 6 
minutes away from any other pick or from the time in the summary line, Hypoinverse 
will ignore that pick.

Two users with different Hypoinverse setups will likely get different location and mag-
nitude results. Careful attention to detail in the setup is important to successful calcu-
lations.
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Appendix B Earthworm

B.1  Introduction
Earthworm is an automatic earthquake processing system developed by the USGS for 
use with seismic networks. It is public domain software available to anyone to down-
load. Information on the Earthworm system can be found at
http://folkworm.ceri.memphis.edu/ew-doc/.

When the term “Earthworm database” is used in this documentation, we mean the Ora-
cle database compatible with Earthworm.

B.2  Atlas and Earthworm installations
Atlas does not require the use of the Earthworm system; however, the Oracle database 
has been set up to be entirely compatible with Earthworm versions 6.0 and 6.1.

Atlas adds a few Atlas-specific tables, functions, and procedures; if these have not been 
added to the database then Atlas treats the database as read-only. None of the existing 
database functionality is changed with the addition of these elements.

Earthworm may be installed after Atlas is installed, skipping the database installation 
step. This assumes Earthworm version 6.0 or 6.1; any subsequent versions of Earth-
worm will require updating the database. Currently, Atlas is guaranteed to work with 
versions 6.0 and 6.1.

See also the Atlas Installation and Maintenance Guide.
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Appendix C Response File 
Format

Nanometrics response files are text files that allow for exchange of instrument response 
information. Atlas can read these response files to obtain instrument response, filter 
groups, and individual filters.

Each response file is divided into 2 sections: a header, and a list of stages. The header 
provides general information about the file as a whole, including the number of stages, 
name, and start and end times. Each section is divided by a line of “-” characters. Each 
stage provides information about the filter it represents, such as units, delay, poles and 
zeroes, and coefficients.

Atlas only requires a field name (such as szName or rtmStartData), a colon, and 
a value. Descriptions after the key name and before the colon are ignored. Atlas does 
not require all the information to be present—Atlas will assume default values for any 
information not present. Field names must start at the beginning of a new line. 

This is an example response file:
Seismometer type       = S13
Data sample rate       = 100 s/s
Selected IIR frequency = 100 mHz corner frequency

ulRespKey          unique response ID                  : 1
szFilename[51]     - name of this file                 : seed.rsp
szDescription      description                         : 100s/s, 100mHz, S13
rtmStartDate       effective date (start)              : 2001-08-

03_01:29:29.0000
rtmEndDate         effective date (= start for current): 2001-08-

03_01:29:29.0000
rtmLoadDate        date loaded into database           : 2001-08-

03_01:29:29.0000
pszDBComment       database comment                    : 
usNumStages        number of stages in  File           : 9

-----------------------------------------------------------
usStageNumber      response list stage number          : 1
ulStageKey         unique database stage key           : 1
usSeedBlockette    43/4.1 SEED blockette equivalent    : 43
szName             43/4.4 Unique identifying name      : S13
chSeedType         43/4.5 type of stage A,B,C or D     : A
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szInputUnits       43/4.6 input units description      : M/S
szOutputUnits      43/4.7 output units description     : V
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 0.000000
usDecimation       47.6 Sampling decimation factor     : 1
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 376.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 1
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 2
usDenTerms         number of poles or denominators     : 2
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 0.000000,0.000000,
0.000000,0.000000,
-4.442210,4.442210,
-4.442210,-4.442210

-----------------------------------------------------------

usStageNumber      response list stage number          : 2
ulStageKey         unique database stage key           : 2
usSeedBlockette    43/4.1 SEED blockette equivalent    : 43
szName             43/4.4 Unique identifying name      : 1500Hz Bessel 3P-LP
chSeedType         43/4.5 type of stage A,B,C or D     : A
szInputUnits       43/4.6 input units description      : V
szOutputUnits      43/4.7 output units description     : V
rNormFactor        43.8 seed optional to normalize     : 1.405680e+012
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 30000.000000
usDecimation       47.6 Sampling decimation factor     : 1
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 3.392000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 1
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 0
usDenTerms         number of poles or denominators     : 3
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : -

9904.800000,3786.000000,
-9904.800000,-3786.000000,
-12507.000000,0.000000

-----------------------------------------------------------

usStageNumber      response list stage number          : 3
ulStageKey         unique database stage key           : 3
usSeedBlockette    43/4.1 SEED blockette equivalent    : 43
szName             43/4.4 Unique identifying name      : A/D converter
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chSeedType         43/4.5 type of stage A,B,C or D     : A
szInputUnits       43/4.6 input units description      : V
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 30000.000000
usDecimation       47.6 Sampling decimation factor     : 1
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 7.880330e+005
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 1
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 0
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 0.000000

-----------------------------------------------------------

usStageNumber      response list stage number          : 4
ulStageKey         unique database stage key           : 4
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : Fir 1 Filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 30000.000000
usDecimation       47.6 Sampling decimation factor     : 5
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 4
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 34
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 3.788775e-005,
1.997269e-004,5.912768e-004,1.198337e-003,1.677196e-003,
1.234444e-003,-1.158774e-003,-6.071729e-003,-1.261023e-002,
-1.766685e-002,-1.615370e-002,-2.631810e-003,2.601663e-002,
6.805387e-002,1.159861e-001,1.582344e-001,1.830499e-001

-----------------------------------------------------------

usStageNumber      response list stage number          : 5
ulStageKey         unique database stage key           : 5
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : Fir 2 Filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
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szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 6000.000000
usDecimation       47.6 Sampling decimation factor     : 3
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 4
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 30
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 6.587914e-005,
1.899969e-004,-4.827186e-005,-1.216777e-003,-2.457607e-003,
-5.687041e-004,6.495283e-003,1.294971e-002,5.449010e-003,
-2.159296e-002,-4.696462e-002,-2.711075e-002,6.566507e-002,
2.029431e-001,3.061833e-001

-----------------------------------------------------------

usStageNumber      response list stage number          : 6
ulStageKey         unique database stage key           : 6
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : Fir 3 Filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 2000.000000
usDecimation       47.6 Sampling decimation factor     : 2
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 4
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 118
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : -1.046905e-005,
-2.377585e-005,-5.718979e-006,3.423591e-005,3.051089e-005,
-4.393138e-005,-7.445012e-005,3.356967e-005,1.362692e-004,
1.277561e-005,-2.025092e-004,-1.122147e-004,2.488128e-004,
2.730092e-004,-2.378789e-004,-4.882986e-004,1.257253e-004,
7.273434e-004,1.293681e-004,-9.317625e-004,-5.524018e-004,
1.016527e-003,1.135685e-003,-8.796328e-004,-1.823778e-003,
4.200994e-004,2.504274e-003,4.363557e-004,-3.008321e-003,
-1.707706e-003,3.124313e-003,3.327176e-003,-2.625743e-003,
-5.122464e-003,1.311452e-003,6.808534e-003,9.463453e-004,
-7.998371e-003,-4.153490e-003,8.232391e-003,8.152581e-003,
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-7.023114e-003,-1.259593e-002,3.905999e-003,1.693529e-002,
1.518937e-003,-2.042215e-002,-9.579908e-003,2.209426e-002,
2.060824e-002,-2.067742e-002,-3.521951e-002,1.417054e-002,
5.525585e-002,1.904586e-003,-8.790202e-002,-4.504146e-002,
1.822970e-001,4.105864e-001

-----------------------------------------------------------

usStageNumber      response list stage number          : 7
ulStageKey         unique database stage key           : 7
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : Fir 5 Filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 1000.000000
usDecimation       47.6 Sampling decimation factor     : 5
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 4
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 56
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 1.278289e-005,
4.864359e-005,1.144121e-004,1.910125e-004,2.191873e-004,
1.043084e-004,-2.426295e-004,-8.288109e-004,-1.497339e-003,
-1.894279e-003,-1.544016e-003,-5.733420e-005,2.574218e-003,
5.724076e-003,8.086910e-003,7.981330e-003,4.009124e-003,
-4.101318e-003,-1.480032e-002,-2.455139e-002,-2.845132e-002,
-2.161206e-002,-9.396188e-004,3.330763e-002,7.683237e-002,
1.218946e-001,1.591557e-001,1.802514e-001

-----------------------------------------------------------

usStageNumber      response list stage number          : 8
ulStageKey         unique database stage key           : 8
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : Fir 3 Filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 1.000000
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 200.000000
usDecimation       47.6 Sampling decimation factor     : 2
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
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usType             NMX response type 0 through 8       : 4
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 118
usDenTerms         number of poles or denominators     : 0
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : -1.046905e-005,
-2.377585e-005,-5.718979e-006,3.423591e-005,3.051089e-005,
-4.393138e-005,-7.445012e-005,3.356967e-005,1.362692e-004,
1.277561e-005,-2.025092e-004,-1.122147e-004,2.488128e-004,
2.730092e-004,-2.378789e-004,-4.882986e-004,1.257253e-004,
7.273434e-004,1.293681e-004,-9.317625e-004,-5.524018e-004,
1.016527e-003,1.135685e-003,-8.796328e-004,-1.823778e-003,
4.200994e-004,2.504274e-003,4.363557e-004,-3.008321e-003,
-1.707706e-003,3.124313e-003,3.327176e-003,-2.625743e-003,
-5.122464e-003,1.311452e-003,6.808534e-003,9.463453e-004,
-7.998371e-003,-4.153490e-003,8.232391e-003,8.152581e-003,
-7.023114e-003,-1.259593e-002,3.905999e-003,1.693529e-002,
1.518937e-003,-2.042215e-002,-9.579908e-003,2.209426e-002,
2.060824e-002,-2.067742e-002,-3.521951e-002,1.417054e-002,
5.525585e-002,1.904586e-003,-8.790202e-002,-4.504146e-002,
1.822970e-001,4.105864e-001

-----------------------------------------------------------

usStageNumber      response list stage number          : 9
ulStageKey         unique database stage key           : 9
usSeedBlockette    43/4.1 SEED blockette equivalent    : 44
szName             43/4.4 Unique identifying name      : IIR filter
chSeedType         43/4.5 type of stage A,B,C or D     : D
szInputUnits       43/4.6 input units description      : COUNTS
szOutputUnits      43/4.7 output units description     : COUNTS
rNormFactor        43.8 seed optional to normalize     : 0.996868
rNormFreq          43.9 seed optional. With 43.8       : 1
rInSamSec          47.5 input sampling rate            : 100.000000
usDecimation       47.6 Sampling decimation factor     : 1
usDecimationOffset 47.7 decimation offset              : 0
rDelayEstimate     47.8 stage delay time (nominal)     : 0.0
rDelayApplied      47.9 applied stage delay            : 0.0
rGainOrSensitivity 48.5 stage sensitivity or gain      : 1.000000
rGainFreq          48.6 frequency of stage gain        : 10
rFrequency         meaning depends on NMX type         : 0.0
usType             NMX response type 0 through 8       : 2
szDesign           how filter was designed             : 
usNumTerms         number of zeros or numerators       : 2
usDenTerms         number of poles or denominators     : 2
rtmLoadDate        date loaded into the database       : Aug 03 2001 01:29AM
pszDBComment       database comment                    : 
Coefficients       - as specified above                : 1.000000,-1.000000,
1.000000,-0.993736

-----------------------------------------------------------

  Notes
  *****

 SEED    Blockette 43   Response poles and zeroes
 type
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  A      Laplace transform analog response, in rad/sec
  B      Analog response in Hz
  C Undefined
  D Digital(Z - transform)

 SEED    Blockette 44  Response coefficients
 type

  A      Laplace transform analog response, in rad/sec
  B      Analog response in Hz
  C Undefined
  D Digital(Z - transform)

  NMX response types

  0 S-plane numerator & denominator coefficients
  1 S-plane poles and zeroes
  2 Z-plane numerator and denominator coefficients
  3 Z-plane numerator coeffs only (symmetric FIR, N taps,
                                  (N+1)/2 coeffs, biggest first
  4 Z-plane numerator coeffs only (symmetric FIR, N taps,
                                  (N+1)/2 coeffs, smallest first
  5 Frequency amplitude response list (not implemented)
  6 Generic corner slope list (not implemented)
  7 Decimation and delay (unit gain)
  8 Gain @ frequency only (not implemented in PMResponse)

NMX to SEED mapping
*******************

  SEED  NMX   Plane
  type  type

  43A     1    S   S-plane poles and zeroes
  44A     0    S   S-plane numerator & denominator coefficients
  44D     2    Z   Z-plane numerator and denominator coefficients

Not supported by MAKESEED
  43D              Z-plane poles and zeroes
  44D     3    Z   Numerator only, biggest first, half set
  44D     4    Z   Numerator only, smallest first, half set

Notes:
  1.  SEED pole position errors not supported

Notes on each field in NMX Stage record
***************************************
  ulRespKey
    Response filename should be anystring.<numeric id>.res

  szDescription
    Typically type of overall response.  Only needed in stage[0].

  rtmStartDate;
  rtmEndDate;
  rtmLoadDate;
  pszDBComment
    Ignored, but may be used in the future
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  usNumStages
    Read from stage[0]. Used to check that expect number of stages are
    present.

  usStageNum
    Ignored for now.  Recommend to put good value.

  ulStageKey
    Assigned by MakeSEED

  usSeedBlockette
    Critical parameter.  Tells MakeSEED kind of blockette to make.

  szName (26)
    Description of stage, e.g. seismometer type, filter type, etc

  chSeedType
    This field is used to tell MAKESEED which type of SEED primary
    blockette to make from this stage. MAKESEED may also make a second
    or secondary blockette from the stage information. See elsewhere
    for details.

  szInputUnits (21)
  szOutputUnits (21)
    Used to build SEED Units Abbreviations Blockette 34

  rNormFactor
  rNormFreq
    Used to set corresponding fields in blockette 43

  rInSamSec
  usDecimation
  usDecimationOffset
  rDelayEstimate
  rDelayApplied
    If rInSamSec is non-zero, causes blockette 48 to be built from this 

info.

  rGainOrSensitivity
  rFrequency
    If rGainOrSensitivity is non-zero, causes blockette 47 to be built
    from this info.

  rGainFreq
    Not used

  usType
    This field is used by PMResponse to set type of response.  Note that
    this field allows several types which are not supported by SEED.

  szDesign (21)
    A place to put how (for example) the FIR coefficients were derived.
    Ignored.

  usNumTerms
  usDenTerms
    Number of each type of coefficients in coefficient field below.

  rtmLoadDate
    Ignored.  Slot for date put in database.
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  pszDBComment
    Ignored.  Slot for comment to put in database.

  Coeffiecients
    All the numerators first.
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Appendix D Troubleshooting

For Atlas support, contact Nanometrics. Please include a detailed description of the 
problem.

Nanometrics, Inc.
250 Herzberg Road
Kanata, Ontario, Canada K2K 2A1
Email: support@nanometrics.ca
Fax: To: Support, (613)592-5929

Table D-1  Troubleshooting FAQs

Question Probable solution

What if Atlas does not start? A possible problem is that settings files have become corrupted. Try 
removing or renaming the atlas.settings file in your user 
directory. Also, try removing or renaming the catalog files, identified as 
*.cat in your user directory.

When I load some events from the 
Nanometrics data server, they are 
blank. Why is that?

Nanometrics data servers use a ringbuffer to store trace data. This 
means that over time trace data will be lost. To exclude events that 
have no trace data, change the catalog criteria to list only the most 
recent events. You can determine how much data is available by listing 
channels with a channel catalog, right clicking on a channel, and 
selecting Details from the pop-up menu.

What if the database has changed 
while I am working?

Right click on a catalog and choose Refresh from the pop-up menu.

Copying events to a SEED file may 
use the all free space on the local 
disk. What should I do?

Because this will generate an error, you should make some work 
around, such as:
• Try to make more space on your local disk, removing unnecessary 

files.
• Because the SEED file became corrupted, try to remove it from the 

user directory.
• Remove the SEED data source from Atlas, close and reopen Atlas, 

and create a new SEED data source.

Is there a limit on the time interval of 
data I can retrieve using a Channel 
type catalog?

There are no programmed limits. However, getting more than a few 
minutes will take a long time. Also, you may exceed the memory limits 
of the machine.
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